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Note: The IMPAX 6.5.1 software complies with the Council Directive 93/42/EEC Concerning Medical
Devices, as amended by Directive 2007/47/EC.

Documentation warranty statement

Characteristics of the products described in this publication can be changed at any time without
notice.

The information contained in this document is subject to change without notice. Agfa HealthCare
N.V. and its affiliates make no warranties or representations, express, implied or statutory, with
regard to this material, including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose.

Agfa HealthCare N.V. and its affiliates shall under no circumstances be liable for any damage arising
from the use or inability to use any information, apparatus, method or process described in this
document. Agfa HealthCare N.V. and its affiliates shall not be liable for errors contained herein or
for incidental or consequential damage in connection with the furnishing, performance, or use of
this manual.

The information in this publication is subject to change without notice.
2011-6-13

Manufacturer’s responsibility

The manufacturer, installer, or importer will be responsible for the safety, reliability, and performance
of the equipment only if:

+ Installation, modifications, adjustments, changes, or repairs are performed by suitably qualified
service personnel.
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* The electrical installation of the site in which the equipment is used is according to an applicable
safety standard (UL, CSA, or IEC/CDE).

* The equipment is used according to the instructions provided in the operation manuals.

* No software other than that which is distributed with this package or is sanctioned by Agfa
will reside on the IMPAX 6.5.1 computers.

Giving feedback on the documentation

(Topic number: 122201)

Thank you for taking the time to provide feedback. Your comments will be forwarded to the group
responsible for this product’s documentation.

To give feedback on the documentation

1. In an email subject line or body, list which product, version, and publication you are
commenting on.

For example, “IMPAX 6.4 SU01 Client Knowledge Base: Extended*. (You can find this
information in the footer of the publications.)

2. Describe the incorrect, unclear, or insufficient information. Or, if you found any sections
especially helpful, let us know.

3. Provide topic titles and topic numbers where applicable.
Including your personal contact details is optional.

4. Send the email to doc_feedback@agfa.com.

Sorry, we cannot respond directly to every submission and we cannot accept requests for changes
in the product; instead, contact your product sales representative or the product’s technical support
channel.
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Getting started

Understanding IMPAX and the hardware and software components required for IMPAX helps
ensure successful installations and upgrades.

Prerequisite knowledge and software

(Topic number: 7760)

The installation procedures require that you have general knowledge of computer hardware and
software concepts and proficiency in operating and troubleshooting computer software. You also
need the hardware and software outlined in the Hardware and software requirements (refer to page
13) section.

Install IMPAX Clients only after the server components of the IMPAX cluster are installed and
configured. Details are available in Order of cluster installations (refer to page 12).

What is IMPAX 6.5.1?

(Topic number: 7749)

IMPAX 6.5.1 combines the traditional activities of RIS informatics management with PACS image
management to provide a powerful platform for imaging-based planning, interpretation, and results
distribution. IMPAX 6.5.1 enables data sharing and data synchronization in a macro enterprise using
a central Data Center.

The IMPAX 6.5.1 Client focuses on the integration of PACS, RIS, and Reporting applications into
a single delivery of information. A single IMPAX 6.5.1 Client application can be used by a range of
users on any appropriate, networked workstation they have access to.
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IMPAX cluster overview

(Topic number: 7791)
Every IMPAX installation is based on the following main components:
* Network Gateway
* Archive Servers
+ Oracle Server or SQL Server
+ Application Server

+ Curator

IMPAX Clients—local and remote

The sum of these components is called the cluster. An IMPAX cluster is the set of core IMPAX
components that contains one database. SPFTP/ASPFTP is used for communication within the
IMPAX cluster. Any third-party display stations are considered to be outside the cluster. They use
DICOM to communicate with the cluster.

A typical installation has a Database Server, one or more Archive Servers, one or more Network
Gateways, and one or more Curators. A third-party load balancer is optional, to help handle many
Clients. Local Clients are spread throughout the entire enterprise, and remote Clients outside the
enterprise firewall. These Clients connect to one or more Application Server machines, either directly
or through a load balancer. The Application Server acts much like a proxy machine to handle security,
authentication, and communication with the IMPAX Server components.

When images are transmitted to the IMPAX cluster, the Network Gateway performs validation of
the study images and data. Validation requires the Network Gateway to query the HIS/RIS and
ensure that the study and patient demographics match what is currently incoming from a modality
or a transmit device. If the validation is successful, the images are “allowed” into the system. The
Database Server collects and manages all patient and study demographic data.

The IMPAX Clients, both local and remote, are used to view study images. Local Clients can get
images directly from the Network Gateway image cache. If images have been archived, the Network
Gateway image cache gets them from the Archive Server. The Curator generates compressed wavelet
images and stores them in a web cache, which may also be seen by local Clients. When a study is
diagnosed and dictated, the status of the study is updated at the Database Server, and when a report
is generated, it is forwarded to the HIS/RIS.
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IMPAX cluster: flow of images
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Deploying IMPAX as a data center with IMPAX
spokes

(Topic number: 11647)

One IMPAX cluster can be set up as central repository (or hub) for archiving studies from several
individual IMPAX clusters, called spokes. This way different sites can share studies while not each
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having to maintain an extensive archive on-site. The hub IMPAX cluster acts as a data center for the

spokes.
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1. Astudyis scheduled for a patient and the details are recorded in the RIS. The study is scheduled
well in advance of the actual appointment, but the order may not be recorded in the RIS until
the day before the exam.

2. The RIS sends the order to the IMPAX Connectivity Manager, using an HL7 notification.
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3. The night before the scheduled study, the Connectivity Manager sends IMPAX notification of
the study and IMPAX automatically searches for and retrieves relevant priors images from the
local archive. This process is called prefetching.

If the facility is part of an enterprise or a multiple IMPAX cluster installation, IMPAX also
searches for relevant priors in the long-term or central storage data center.

4. The patient arrives and needs to be admitted to the facility to have a study performed. The
system checks the ADT to see if a record already exists for the patient. If so, that patient ID is
used; otherwise, a new patient ID is generated.

5. The study is performed on a modality and is sent to the local IMPAX cluster.
6. HIS verification is performed on the patient demographics of the study.

7. When IMPAX receives the study, it checks to see if it needs to get relevant priors from the local
archive and fetches them. This process is called autofetching. It generally occurs when prefetching
cannot be performed or when studies have been added to the archive.

In an enterprise installation, the search includes priors stored in the data center.
8. When the radiologist completes the report, it is sent to the Connectivity Manager.

9. The Connectivity Manager sends the report to the Application Server, where it is forwarded
to the IMPAX archive for storage. If the RIS is an IMPAX RIS or a queryable one, the report
is stored on the RIS.

In an enterprise installation, the Connectivity Manager also sends the completed report to the
data center’s Connectivity Manager, using HL7. At this point, the study will also be sent to the
data center.

Order of cluster installations

(Topic number: 7763)

The IMPAX cluster has many components and each depends on other components in the cluster.
To correctly install and configure components in the cluster, follow this order of installation:

1. Install the Database Server, Archive Server, and Network Gateway.

Install the core Server components and create the portable password file required to install
other IMPAX components. Do not configure the AS300 Server components at this time; the
Application Server must be installed before these Server components can be configured. Refer
to the guide appropriate to your configuration.

Required guide: One of IMPAX 6.5.1 AS3000 Installation and Configuration Guide or IMPAX
6.5.1 AS300 Installation and Configuration Guide

2. Install the Application Server.
Install the Business Application services and IMPAX documentation on the Application Server.
Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide

3. Begin configuration of the Application Server.
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Create and import an SSL certificate, configure ADAM (Windows Server 2003) or AD LDS
(Windows Server 2008), compress web services, set connections to the image and audit servers,
and set logging levels.

Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide

4. Ifyouhaveinstalled a Windows-based Database Server, Archive Server, or Network Gateway,
configure these components.

Configure database backups, image and web caches, and archives (if necessary). In clusters
that include only Solaris-based systems, these configuration steps are done automatically during
the installation.

Required guide: IMPAX 6.5.1 AS300 Installation and Configuration Guide
5. Install and configure Curator and the CD Export server.

If the site requires compressed web images, install and configure one or more Curator systems
and set up the web cache. If you are installing multiple Curators, install and start the master
Curator first, then install and start the slave Curators.

If you will be using the CD Export feature in the IMPAX Client, install the CD Export server.
Required guide: IMPAX 6.5.1 Curator and CD Export Server Installation Guide
6. Complete the configuration of the Application Server.
Complete the optional Application Server configuration tasks that are applicable to the site.
Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide
7. Install and configure Clients.
Install and configure the IMPAX Client, the PACS system used to access images.
Required guide: IMPAX 6.5.1 Client Installation, Upgrade, and Configuration Guide
If installing a standalone station (single-host AS300 with Application Server and Client), refer to the
IMPAX 6.5.1 Standalone Installation and Configuration Guide.

If installing a single-server (single-host AS300 with Connectivity Manager and Application Server),
consult Installing an IMPAX AS300 single-server in the IMPAX 6.5.1 AS300 Installation and
Configuration Guide.

All documentation is available on the IMPAX Documentation DVD.

Hardware and software requirements

(Topic number: 7794)

The following lists the recommended hardware and software for an IMPAX Client workstation.
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IMPAX Client: Hardware requirements
(Topic number: 7793)

The following hardware configuration is recommended for new workstations. While IMPAX Client
should work on an equivalent platform, optimal results can be guaranteed only on the recommended
platform.

To use the CT-MR navigation tools, we strongly recommend that, due to the high volume of data
being manipulated, Client systems be equipped with a high-end video subsystem that is PCle X16
based.

B caution

For official diagnostic interpretation, we recommend setting the display to 32-bit color or more.

Component Requirements

System The Agfa preferred supplier is HP.
HP xw4400, xw4600, xw6400, xw6600, z400, or z600
Dell Precision™ 490 or 690, T5400, T7400, or T7500
Motion LE1600 Tablet PC (Non-diagnostic)

CPU 2 x 2.0GHz or higher
1 x Dual/Quad Core 2.8GHz or higher
1 x Intel® Pentium® M 1.5GHz (Tablet PC — Non-diagnostic)

RAM Windows XP: 1 GB minimum
Windows Vista and Windows 7: 4 GB minimum

4 GB recommended for all new systems for optimal performance and
viewing of large volume image sets

4 GB recommended for IMPAX Clinical Applications such as IMPAX
Virtual Colonoscopy, IMPAX PET-CT Viewing, and IMPAX Reporting
(embedded speech recognition)

RAM (Tablet OS) 512 MB min (Non-diagnostic Tablet PC only)
Hard drive space 80 GB minimum
Modem Not applicable
DVD-ROM drive Yes
Floppy drive Not applicable
Network interfaces System comes with an integrated 100/1000 Mbps Ethernet adapter
Power supply Default
Peripherals Scroll mouse and keyboard
Client Installation, Upgrade, and Configuration Guide—IMPAX 6.5.1 14
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Component Requirements

Other
Video

Diagnostic review

diagnostic review
workstations

RIS/Administrator
stations and Clinical
review stations

For North America, the Logitech MX518 is used with the MA3000.

Microsoft supported DVD RW/CDRW

Windows 7 (WDDM)*:

workstations and high-end  \yp11715 0,2150

MXRT5200 (covers 98% of the
diagnostic requirements)

MXRT7200 (high end board for
IMPAX Clinical Applications such
as Qasis for IMPAX)

MXRT7300 (high end board for
IMPAX Clinical Applications such
as Oasis for IMPAX. Supported
from WDDM v1.1 May/June 2010)

Windows 7 (WDDM):

NVIDIA FX 1700, FX 1800, FX
4800

ATT 3700, 3750, V3800 (third
monitor board)

MXRT 1150/2150 (third monitor
board)

Windows XP and Vista:
BarcoMed PCle for Coronis
BarcoMed PCle for Nio

BarcoMed PCle 5SMP2FH (only
with monitor MF GD-5621HD)

MXRT 2100/5100/7100 (not sold
anymore but still supported)

MXRT5200 (covers 98% of the
diagnostic requirements)

MXRT200 and 7300 (high-end
board for IMPAX Clinical
Applications such as Oasis for
IMPAX)

Windows XP and Vista:

NVIDIA FX 1700, FX 1800, FX
4800

ATT 3700, 3750, V3800 (third
monitor board)

MXRT 1150/2150 (third monitor
board)

*Windows 7 and WDDM drivers do not support the BarcoMed and older MXRT (2100, 5100. and

7100) boards.

IMPAX Client: External software requirements

(Topic number: 6694)

The following software is required for all new stations. Unless otherwise indicated, Agfa does not
provide the software as part of the IMPAX Client installation package.

Component

Requirements

Operating system

Microsoft Windows XP Professional SP3 may be used for upgrades but

is no longer available for shipment

Microsoft Windows Vista™ / Windows Vista x64 ( Business and Ultimate)

SP2
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Component Requirements

Windows 7 Professional 64-bit (single language support), Windows 7
Ultimate 64-bit (multi-language support) SP1 for Diagnostic review
stations

Note that other versions of Windows 7 can be used for non-diagnostic
review stations.
Other software Microsoft Internet Explorer 7.0 and 8.0
NET 3.5 SP1
Latest version of Adobe® Reader®

Antivirus software such as Norton Antivirus 6.1 or higher, Trend Micro,
or McAfee Antivirus 4.5 or higher

Note that Oracle 11 Client is required for IMPAX Reporting and IMPAX
for Cardiology.

The IMPAX Client will run on 64 bit operating systems in 32bit compatibility mode. The IMPAX
Client is not a 64bit application and therefore does not take advantage of 64bit processing or memory
addressing.

% Note:

We recommend upgrading Windows Vista to Windows 7 for systems that will be used as
diagnostic workstations.

IMPAX Client: Smart card reader and driver requirements
(Topic number: 66934)

The following smart card readers are recommended for use with the IMPAX Client.

Smart card reader name Product number Model number Driver version
USB smart card readers

ActivCard USB Reader V2 ZFG-9800-AC V2 3.2.0.1

SCM Microsystems SCR301 USB ~ ZFG-9800-AA SRR200 2.9.0.0

Smart Card Reader

SCRx331 USB Reader 902748 rev 1.0 1.40.0.0
SCR301 USB Smart Card Reader ~ 902890 Rev 1.0 SCR 301 2.9.0.0

(Light Grey)

CardMan 2020 (Cherry) ST-1000UA/02 ST-1000U 3.7.3.12
Keyboards with smart card readers
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Smart card reader name Product number Model number Driver version

SmartBoard XX44 (Cherry) Article # RS 6700 USB 1.1.0.32
G83-6744LUAUS-2/00

GTI333 Smart Card Reader KFKE90YF 1.16.0.1

(Keyboard)

Dell USB Keyboard Smart Card SK-3106 2.0.0.13

Reader

Dell Smart Card Reader Keyboard RT7D60 1.0.0.2

MPC Smart Card Reader USB SK-3105S KBR001160-00 2.0.0.13

Keyboard (Grey)

PCMCIA smart card readers

GemPC400 PCMCIA Smart Card 2.1.10.1

Reader

Omnikey AG CardMan 4000 5.1.2600.2180

PCMCIA Smart Card Reader

CardMan 4040 1.1.0.24

IMPAX Client hardware and software recommendations
(Topic number: 121271)

Agta recommends the following hardware and software for diagnostic, RIS stations, and clinical
review stations.

High performance diagnostic workstation—HP xw4600 or HP z400

The high performance diagnostic workstations are recommended for systems used primarily for
viewing large volume image sets (such as 64-slice CT) and using third-party applications such as
Volume Viewing, TalkStation, Orthopaedic planning tools, and so on. These Clients are typically
used inside a hospital environment such as a radiology reading area by radiologists.

Component Requirements

RAM 8 GB (2*2, 1¥4) minimum

Operating system Windows 7 Professional or Ultimate/64 bit, 32 bit emulation
Processor Single quad-core processor

Standard performance diagnostic workstation—HP xw4600 or HP z400

The standard performance diagnostic workstation systems can be used for the review and reporting
of all diagnostic studies; however, the high performance diagnostic workstations are preferred for
viewing of large volume data sets.
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Component Requirements

RAM 4 GB
Windows 7 Professional or Ultimate/64 bit, 32 bit emulation

Operating system

Processor Single quad-core processor

RIS station—HP z200

A RIS station is not suitable to use as a diagnostic workstation.

Component Requirements

RAM 4GB

Operating system Windows 7 Professional or Ultimate, 32 bit
Graphics card ATT FirePro V3700 or V5700

Processor Dual quad-core processor

Clinical review station—HP z200
A clinical review station is not suitable to use as a diagnostic workstation.

Component Requirements

RAM 4 GB

Operating system Windows 7 Professional or Ultimate/64 bit, 32 bit
emulation

Graphics card ATT FirePro V3700 or V5700

Processor Dual quad-core processor

Installation preparation checklist

(Topic number: 7790)

Obtain the following information and equipment before installing the operating system.

Required operating system installation information
Drive letter of the CD-ROM drive (typically D)

When you begin the installation, the screen resolution is set to
640x480. If working on a 2, 3, or 5 Mega Pixel monitor, you need
the following to view the installation program:

+ Extra video adapter compatible with an SVGA monitor

+ Separate viewing monitor
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Required operating system installation information

Organization name

Computer name

Administration user ID and password
Appropriate regional settings

Whether the network setting is Workgroup or Domain

Which video board is on the system

Obtain the following information before installing the IMPAX software.

Required IMPAX Client installation information

Whether accessing the Client installation program from CD, from
an Installation Server, or using an automated process.

+ If from an Installation Server, the Server name is required.
+ If using an automated process, the command line options

must be defined and a batch file created (or software
distribution tool used).

Whether one specific user or any licensed user will be logging into
IMPAX on this computer.

For specific users, their Windows user name is required.
The fully qualified domain name of the Application Server this
Client is to connect to.

Whether the Clinical Application/third-party software is being
installed.

+ If so, whether a hardware dongle or software key is installed
on each workstation or on a server.

+ If the dongle or key is installed on a server, the server’s IP
address.

Whether the TalkStation Client software is being installed.

* If so, the name of the TalkStation Server.

Whether the IMPAX RIS Client software is being installed.
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Opening the IMPAX Client Knowledge Base

(Topic number: 57452)

The IMPAX 6.5.1 Client Knowledge Base: Extended is a comprehensive set of information that
details how radiologists, clinicians, specialists, and PACS administrators configure and use the
IMPAX Client software. The Knowledge Base provides targeted getting started information, concepts,
and tasks for various user groups, and focuses on task-based and workflow-based information.

The IMPAX Client Knowledge Base: Core is available in 19 languages. The IMPAX 6.5.1 Client
Knowledge Base: Extended is available in English. Any or all languages can optionally be installed
and can be viewed on the Documentation DVD.

Viewing the Client Knowledge Base from the documentation DVD
(Topic number: 57437)

All IMPAX Knowledge Bases, including the IMPAX Client Knowledge Base, can be viewed directly
from the IMPAX documentation DVD.

To view the Client Knowledge Base from the documentation DVD
. Insert the IMPAX documentation DVD.

1

2. Navigate to /docs/client/knowledge_base.

3. Double-click default.htm.

4. Select the appropriate language for the IMPAX Client Knowledge Base.

Opening the Client Knowledge Base from the List, Text, or Configure

darea
(Topic number: 57440)

Once the IMPAX documentation is installed, you can access it from the IMPAX Client application.

To open the Client Knowledge Base from the List, Text, or Configure area
1. Press F1.

or

From the List or Configure area bar, click Help.

The home (or main) page of the Client Knowledge Base opens in a browser window. It normally
appears in the same language used for the IMPAX interface; for example, if working with IMPAX
in French, the French Knowledge Base opens. If the Knowledge Base is not available in the interface
language (usually because that Knowledge Base was not installed), you must manually redirect the
URL to the English Knowledge each time you open the Knowledge Base.
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Installing external
software

Several external software applications must be installed to run the IMPAX 6.5.1 Client.

External software: Order of installation tasks

(Topic number: 7799)

You must install and configure the software in the order it is listed. For more information on installing
the required external software, refer to the documentation provided with the software or consult
the vendor’s website.

Windows XP

Installed Task

Installing Microsoft Windows XP (refer to page 23)

Installing Windows XP SP3 (refer to page 24)

Installing device drivers on the computer (refer to page 96)
Installing video drivers (refer to page 27)

Installing a modem (refer to page 27)

Upgrading the Internet Explorer version (refer to page 28)
Installing Adobe Reader (refer to page 28)

Installing and configuring antivirus software (refer to page 29)
Installing and using VNC ROI (refer to page 29)

Supporting integrated TalkStation (refer to page 29)

Installing Microsoft Word (refer to page 33)
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Installed

Installing the hardlock driver (refer to page 34)
Installing the smart card reader (refer to page 34)

Completing other initial Windows XP configurations (refer to page 37)

Windows Vista

Installed Task

Installing Microsoft Windows Vista (refer to page 24)
Installing device drivers on the computer (refer to page 96)
Installing video drivers (refer to page 27)

Installing a modem (refer to page 27)

Upgrading the Internet Explorer version (refer to page 28)
Installing Adobe Reader (refer to page 28)

Installing and configuring antivirus software (refer to page 29)
Installing and using VNC ROI (refer to page 29)
Supporting integrated TalkStation (refer to page 29)
Installing Microsoft Word (refer to page 33)

Installing the hardlock driver (refer to page 34)

Installing the smart card reader (refer to page 34)

Completing other initial Windows Vista configurations (refer to page 39)

Windows 7

Installed Task

Installing Microsoft Windows 7 (refer to page 26)

Installing device drivers on the computer (refer to page 96)
Installing video drivers (refer to page 27)

Installing a modem (refer to page 27)

Upgrading the Internet Explorer version (refer to page 28)
Installing Adobe Reader (refer to page 28)

Installing and configuring antivirus software (refer to page 29)
Installing and using VNC ROI (refer to page 29)

Supporting integrated TalkStation (refer to page 29)

Installing Microsoft Word (refer to page 33)
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Installed

Installing the hardlock driver (refer to page 34)
Installing the smart card reader (refer to page 34)

Completing other initial Windows 7 configurations (refer to page 42)

Installing Microsoft Windows XP

(Topic number: 7781)
Follow these instructions to install Microsoft Windows XP for new Client workstations.

To install the hard disk drivers
1. Insert the Windows XP Professional CD.

2. Boot from CD.

To boot from CD on a Dell workstation, press F12, select Onboard or USB CD-ROM drive,
press Enter, then press any key.

3. To install third-party or OEM drivers, press F6.
Files are loaded.
4. If installing on a Dell workstation, also perform the following steps:
a. On the Windows Setup screen, to specify additional drivers, type S.

b. Insert the floppy disk containing the extracted Adaptec SATA Host Raid Controller that
you created in preparation.

c. When the driver name is displayed, to select it, press Enter.
d. When prompted to continue, press Enter.

e. When the installation is finished, remove the floppy disk.

To install Windows XP Professional
On the Windows Setup screen, when prompted, press Enter.

To accept the End User License Agreement, press F8.
To create a disk partition, press C.
Use the drive letter C:\, the Volume Label SYSTEM, and all available disk space.

To save the partition, press Enter.
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Select Format the Partition using NTFS File System (the default) and press Enter.
The partition is formatted and files are copied. The computer then restarts.

7. For the Regional and Language options, select the country and language appropriate for the
site where the client will be used. Click Next.
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8. Follow the setup wizard using the selections specified on the order.

Organization Name Site’s name

Computer Name As specified on order

Administration Password As specified on order

Date and Time As appropriate for the system

Networking Typical

Workgroup/Domain Talk to the site’s IS department for the appropriate setting.
If intending to use integrated Windows authentication,
Domain must be used.

9. To restart the computer, click Finish.

After the computer has restarted, log into Windows as an administrator-level user.

Installing Windows XP SP3

(Topic number: 60672)

If using Windows XP, for added security, we recommend installing Service Pack 3.

To determine whether you require Windows XP SP3
1. Right-click My Computer and select Properties.

2. If Service Pack 3 is listed under System on the General tab, you do not have to install it.
3. To close the dialog, click OK.

To install Windows XP SP3
1. Double-click the Windows XP SP3 executable (.exe) file.

2. To accept the license agreement, click I Accept.
3. Accept the defaults on each screen and click Next.
The installation process takes over an hour.

4. After the installation completes, to restart the system, click Restart Now.

When the computer restarts, log into Windows as an administrator-level user.

Installing Microsoft Windows Vista

(Topic number: 49316)

Follow these instructions to install Microsoft Windows Vista for new Client workstations.
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E Note:

If the workstation is currently running a previous version of Windows and will be upgraded to
Windows Vista, upgrade the operating system before installing the IMPAX Client (refer to
page 25). Windows Vista is not a supported operating system for Standalone workstations.

To install Microsoft Windows Vista
1. Insert the Windows Vista DVD and restart the computer.

2. When prompted, press any key on the keyboard.
3. Follow the installation prompts.
4. Restart the computer.
5. After the computer has restarted, complete the configuration of Windows Vista (refer to page
39).
Organization Name: Site’s name
Computer Name: As specified on order
Administration Password: As specified on order
Date and Time: As appropriate for the system
Networking: Typical
Workgroup/Domain: Talk to the site’s IS department for the appropriate setting.
If intending to use integrated Windows authentication,
Domain must be used.

Switching to Windows Vista from Windows XP
(Topic number: 49319)

We recommend removing the previous operating system before installing Windows Vista.

E Note:

You must be connected to the internet during the upgrade to Windows Vista.

To switch to Windows Vista from Windows XP
1. Backup all important files on the computer.

2. Uninstall the previous operating system from the computer.

3. Install Microsoft Windows Vista from the DVD (refer to page 24).
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Installing Microsoft Windows 7

(Topic number: 104087)

Follow these instructions to install Microsoft Windows 7 for new Client workstations.

To install Microsoft Windows 7
1. Insert the Windows 7 DVD and restart the computer.

2. When prompted, press any key.
3. Follow the installation prompts.

For diagnostic review stations, you must select Windows 7 Professional 64-bit (single language
support) or Windows 7 Ultimate 64-bit (multi-language support). For non-diagnostic review
stations, other versions of Windows 7 can be used.

4. Restart the computer.

5. After the computer has restarted, complete the configuration of Windows 7 (refer to page 35).

Tip:

To view an extended context menu in Windows 7, press Shift + right-click; for example,
press Shift + right-click a taskbar icon and select Restore.

Organization Name: Site’s name

Computer Name: As specified on order

Administration Password: As specified on order

Date and Time: As appropriate for the system

Networking: Typical

Workgroup/Domain: Talk to the site’s IS department for the appropriate setting.
If intending to use integrated Windows authentication, you
must use Domain.

Installing Windows 7 SP1

(Topic number: 130089)
If using Windows 7, we recommend installing Service Pack 1.

To install Windows 7 SP1
1. Right-click Computer and select Properties.

2. If Service Pack 1 is listed under Windows Edition, you do not have to install it.
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To install Windows 7 SP1
1. Goto
hitpy/mwwmicrosoft com/downloads/en/detailsaspx?FamilyID=c3202ce6-4056-4059-8a1b-3a9b77cdfdda&displaylang=en
2. Click Continue.

3. Choose either the 32-bit (x86) or the 64-bit (x64) version of SP1 depending on whether you
are running the 32-bit or the 64-bit version of Windows 7.

To find out which version you are running, right-click Computer and select Properties. Under
System, next to System type, you can view the operating system.

Click Download.
To install SP1 immediately, click Open or Run.
Follow the instructions on your screen.

On the Install Windows 7 Service Pack 1 page, click Next.
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Follow the instructions on your screen.
Your computer might restart during the installation.
9. After the installation completes, log on to your computer at the Windows logon prompt.

You might see a notification indicating whether the update was successful.

Installing video drivers

(Topic number: 7768)

If using Barco cards, you must install the current set of Barco drivers, which control the video boards.
Follow the installation instructions you received with the Barco CD. For complete details, refer to
the manufacturer’s documentation.

% Note:

If you are not using Barco cards, skip these installation instructions and continue with the next
topic.

Installing a modem

(Topic number: 7681)

The modem is an optional component. If necessary, install the external modem according to the
manufacturer’s instructions.
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Upgrading the Internet Explorer version

(Topic number: 131184)

If running an earlier version of Internet Explorer, we recommend that you upgrade the version. To
verify which version of Internet Explorer is being used, start Internet Explorer and select Help >
About Internet Explorer.

To upgrade the Internet Explorer version
1. Launch Internet Explorer on a computer connected to the Internet.

2. Goto

http://windows.microsoft.com/en-US/internet-explorer/help

Select the support version you want to upgrade to.

From this page, you can either download Internet Explorer or order it on CD.

Once you have obtained the software, run it on each server that needs upgrading.

AL

To install the software, follow the on-screen prompts.

Installing Adobe Reader

(Topic number: 7679)

E Note:

This installation procedure requires a direct Internet connection. If the system does not have
a direct Internet connection, you can use a local Software Update Server instead. To set up
a Software Update Server, contact your IT department.

The IMPAX 6.5.1 guides, quick references, and task summaries ship with the product in PDF format.
To view and print the files, install the latest version of Adobe Reader.

To install Adobe Reader

1. Go to http://get.adobe.com/reader.
2. Clear the checkbox for optional software such as the Google Toolbar and McAfee Scan.
3. Click Download now.
4. Run the install executable.
5. In the Acrobat Reader Installation Wizard, select the appropriate options on each screen. After
each selection, click Next.
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http://get.adobe.com/reader

Installing and configuring antivirus software

(Topic number: 10269)

Install and configure the antivirus software according to the manufacturer’s instructions.

E Note:

Once the IMPAX software is installed, create rules in the antivirus software to exclude IMPAX
processes that are running on IMPAX Clients and Servers. For example, exclude .dcm and
.inf files on IMPAX Client workstations and IMPAX web services on Application Servers.

Installing and using VNC ROI

(Topic number: 55096)

VNC stands for Virtual Network Computing. It is remote control software which allows you to view
and fully interact with one computer desktop (the VNC server) using a simple program (the VNC
viewer) on another computer desktop anywhere on the Internet. VNC can be used to select the
region of interest for collaboration with other users of VNC.

E Note:

All Client workstations using VNC ROI should be on the local network. VNC ROI should not
be installed on remote Clients as security or performance may be adversely affected.

For instructions on installing and using VNC ROI, refer to the VNC ROI Instructions document
(PDF).

Supporting integrated TalkStation

(Topic number: 7755)

If the TalkStation Client is to be installed on this workstation, you must also install the following
Windows components.

E Note:

IMPAX 6.5.1 supports integration with TalkStation 4.0.
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Replacing an existing sound car or installing a new one
(Topic number: 7770)

For the TalkStation integration with IMPAX to work properly, you must install a sound card.

To replace an existing sound card or install a new one
1. Open Control Panel.

2. Select Sounds and Audio Controls.
3. Select the appropriate options for your sound card.

For details, refer to the sound card manufacturer’s instructions.

Installing the microphone
(Topic number: 7772)

For the TalkStation integration with IMPAX to work properly, you must install the microphone.

B caution

Exit from TalkStation before installing the SpeechMike. The keys are automatically mapped
by TalkStation and will conflict with the installation.

To install the SpeechMike

1. From the TalkStation DVD, CD 1, or mapped network drive, navigate to
\SpeechMike\V2301405 and double-click V2301405.exe.

2. For details, refer to the manufacturer’s instructions.

The SpeechMike has several buttons that may be mapped to TalkStation function keys. You
can configure these settings after installing TalkStation. For suggested settings, refer to the
TalkStation 4.0 User Knowledge Base.

To install a Labtec headset
1. Refer to the manufacturer’s instructions.

Testing the sound system
(Topic number: 7754)

Once the sound card and microphone are installed successfully, verify that you can record audio.

To test the sound system
1. Restart the computer.
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2. To open the Microsoft Sound Recorder, select Start > All Programs > Accessories >
Entertainment > Sound Recorder.

If your microphone has an on/off power switch, ensure that it is on.
In the Sound Recorder dialog, click Record. @ |

Speak normally into the microphone for 2-3 seconds.

Click Stop. | = |

Click Play. » |
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You should hear your voice in a clear, audible tone. You should not hear excessive crackling or
scratching. You should not have to turn the volume up high. If this is not the case:

+ Check that the microphone is plugged into the appropriate jack in the sound card.
* Check that the microphone is on.
* Check that the sound card drivers are correctly installed and configured.

+ Using the sound mixer, check that the microphone gain settings are adjusted properly.

Supporting integrated IMPAX Reporting

(Topic number: 107578)

If IMPAX Reporting is to be used as the reporting solution (that is, for creating reports, through
either speech recognition or transcription), the Oracle Client, the SpeechMike, and the Speech client
must be installed on this workstation.

The IMPAX Reporting supports Nuance SpeechMagic 5.1 and 6.1 SP2 Fix-pack 8 as its speech
recognition software. Consult the IMPAX RIS documentation for more details.

Installing the Oracle Client

(Topic number: 114133)

The Oracle Client must be installed on the IMPAX Client workstation for any IMPAX Reporting
integration. You must install Oracle Client 11 with OLEDB provider.

We recommend a minimum installation of the following Oracle Client components:
« SQL *Plus

+ Oracle Windows interfaces (includes ODBC and OLE DB)
+ Oracle NET

We strongly recommend streamlining naming conventions in your TNSNAMES.ORA across the
whole enterprise. Typically the IMPAX RIS database has the QPROD service name.
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Important!

If the workstation’s operating system is Windows Vista 64-bit, install Oracle Client 32-bit. The
integrated solution does not work with Oracle Client 64-bit, because the IMPAX RIS
components require 32-bit Oracle.

To install the Oracle Client
1. Install the Oracle Client software according to Oracle's installation instructions.

Installing and configuring the SpeechMike
(Topic number: 115249)

A SpeechMike must be installed on each workstation using IMPAX Reporting.

To install and configure the SpeechMike

1. For installation and configuration instructions, refer to the documentation accompanying the
SpeechMike.

Installing the Speech client

(Topic number: 107581)

The Speech client must be installed on each workstation using IMPAX Reporting.

% Note:

If you upgrade or reinstall Microsoft Word after the installation of the Speech client, you must
reinstall the Speech client software to accept the upgraded Microsoft Word.

To install the Speech client
1. Refer to the SpeechMagic Installation and Upgrade Guide for current and complete instructions.

% Note:

Always select Speech Interactive, even if the workstation is not used for online dictation
(for example, only used for digital or offline dictation).

To check the Speech client installation
1. When the installation is complete, check the registry setting for COM Addins.

Operating system COM Addins
Windows XP and Windows Vista [HKLM ]/Software/Microsoft/Office/Word/Addins/
32-bit SmlaWordDocumentAddin.Connect
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Operating system COM Addins

Windows Vista 64-bit and Windows [HKLM]\Software \WOW6432Node
7 \Microsoft\Office\Word\Addins\
SmIaWordDocumentAddin.Connect

% Note:

The LoadBehavior must be set to 3. If itis set to 2, the addin has probably been disabled
by Microsoft Word. To enable the COM Addin in Microsoft Word, from the Help menu,
select About Microsoft Office Word > Disabled Items, select COM Addins, and click
Enable.

2. Check if the Addin DLL is registered. If necessary, register the file manually:
regsvr32 SmlaWordDocumentAddin.dll

Installing Microsoft Word

(Topic number: 7756)

The IMPAX RIS Client software can be integrated with Microsoft Word; therefore, to fully support
it, you should install Microsoft Word.

% Note:

We recommend Microsoft Word 2003 SP3 or Microsoft Word 2007 SP1 for the IMPAX
Reporting.

To install Microsoft Word
1. Refer to the installation instructions provided by Microsoft.

2. Once you have installed Word, launch it and accept the End User License Agreement.

Note the following when using Microsoft Word with IMPAX Reporting:

+ To ensure optimal performance, you must optimize Microsoft Word. Refer to "Microsoft Word
optimizations: Reference" (topic number 107256) in the IMPAX 6.5.1 Client Knowledge Base:
Extended.

+ The Microsoft Word templates cannot be on a shared drive. Ensure the templates are on a local
drive for each Client.
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Installing the hardlock driver

(Topic number: 10027)

The hardlock driver on the installation CD provided by HecTec does not work with Windows XP
SP3. The problem can occur with standalone Agfa Orthopaedic Tools (AOT) v2.10 using the parallel
or USB dongle, and with network Agfa Orthopaedic Tools (AOT) v2.10 using the USB dongle.

To install the hardlock driver
1. In Internet Explorer, navigate to:

ftp://ftp.ealaddin.com/pub/aladdin.de/hardlock/hldinst.zip

In the File Download dialog, click Save.

Save the hldinst.zip file to a location on the hard drive.

Open a command prompt.

At a command prompt, navigate to the directory where you stored the downloaded driver.

At a command prompt, type hldinst -remove.
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At a command prompt, type hldinst —install.

Installing the smart card reader

(Topic number: 41227)

To authenticate users using a smart card, a smart card reader must be installed at each IMPAX Client
station.

To install the smart card reader
1. For installation instructions, refer to the documentation accompanying the smart card reader.
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Configuring the
Windows operating
system

We recommend changing certain default Microsoft® Windows® operating system settings to improve
the display of images in the IMPAX Client, particularly on diagnostic monitors. We also recommend
reviewing what languages are supported in the Client, Knowledge Base, and Administration Tools.

Windows: Order of configuration tasks

(Topic number: 49331)

You must configure Windows in the order it is listed. For more information on configuring the
operating system, refer to the documentation provided with the software or consult the Microsoft
website.

Windows XP

Configured Task

Configuring the Windows XP Control Panel (refer to page 37)
Overwriting Windows events as necessary (refer to page 40)
Configuring Windows Explorer to show all files (refer to page 37)
Creating a temporary directory (refer to page 38)

Changing the desktop colors on Windows XP (refer to page 38)

Enabling Automatic Updates for critical Windows XP or 2003 updates (refer to page
39)

Changing the Windows taskbar settings (refer to page 45)
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Configured

Enabling active content for the Knowledge Base (refer to page 45)
Configuring languages on Windows XP (refer to page 47)

Optional: Configuring the smart card removal behavior setting (refer to page 55)

Windows Vista

Configured Task

Switching to Windows Vista Control Panel classic view (refer to page 39)
Overwriting Windows events as necessary (refer to page 40)

Configuring Windows Explorer to show all files on Windows Vista (refer to page 40)
Creating a temporary directory (refer to page 40)

Disabling animation on Windows Vista (refer to page 41)

Changing the desktop colors on Windows Vista (refer to page 41)

Enabling Automatic Updates for critical Windows Vista updates (refer to page 42)
Changing the Windows taskbar settings (refer to page 45)

Enabling active content for the Knowledge Base (refer to page 45)

Configuring languages on Windows Vista (refer to page 50)

Optional: Configuring the smart card removal behavior setting (refer to page 55)

Windows 7

Configured Task

Configuring the Windows 7 Control Panel (refer to page 42)

Overwriting Windows events as necessary

Configuring Windows Explorer to show all files on Windows 7 (refer to page 43)
Creating a temporary directory (refer to page 40)

Disabling animation on Windows 7 (refer to page 43)

Changing the desktop colors on Windows 7 (refer to page 44)

Enabling Automatic Updates for critical Windows 7 updates (refer to page 44)
Changing the Windows taskbar settings (refer to page 45)

Enabling active content for the Knowledge Base (refer to page 45)

Configuring languages on Windows 7 (refer to page 53)

Optional: Configuring the smart card removal behavior setting (refer to page 55)
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Completing other initial Windows XP configurations

(Topic number: 7729)

We also recommend the following Windows configurations.

Configuring the Windows XP Control Panel

(Topic number: 7806)

By default, Windows XP uses different Control Panel categories than previous releases of Windows.
To follow the procedures in this guide, change it to display the classic Windows categories instead.

To configure the Windows XP Control Panel
1. Open Control Panel.

2. In the left pane, under Control Panel, select Classic View.

The Control Panel window refreshes to display the same categories as in previous releases of Windows.
In the left pane, Icon View is displayed under the Control Panel heading.

Overwriting Windows events as necessary
(Topic number: 47540)

IMPAX functions better when Windows events are overwritten as needed.

To overwrite Windows events as necessary
1. Open the Windows Administrative Tools and select Event Viewer.

2. Complete the following steps for each log under Windows logs and Application and Services
logs in the Event Viewer:

a. Right-click the log and select Properties.
b. Under Log Size, select Overwrite events as needed. Click OK.

Configuring Windows Explorer to show all files
(Topic number: 47547)

We recommend that you display all available files in Windows Explorer.

To configure Windows Explorer to show all files
1. Open Windows Explorer.

2. Select Tools > Folder Options.
3. Switch to the View tab.
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4. Under Files and Folders, select Show hidden files and folders.
5. Clear the Hide extensions for known file types checkbox.
6. To save the changes, click OK.

Creating a temporary directory
(Topic number: 47571)

Having a temporary directory on the server can be useful for storing files in the short term.

To create a temporary directory
1. In Windows Explorer, select the C:\ drive.

2. Select File > New > Folder.

3. Rename the new folder as temp.

Changing the desktop colors on Windows XP

(Topic number: 7739)

The default desktop colors for windows and title bars may be too bright for the lighting conditions
in reading rooms, particularly on diagnostic monitors. You can change these colors as needed.

To change the desktop colors on Windows XP
Open Control Panel.

Select Display.
In the Display Properties dialog, switch to the Appearance tab.
Click Advanced.

To change the background color of windows and dialogs, from the Item list, select Window.

A .

By default, windows and dialogs are pure white. White is very bright on diagnostic monitors.
6. Click Color 1 and select an alternative color, such as gray or off-white.
7. To change the title bar color, from the Item list, select Active Title Bar.

Title bars are bright blue by default.
8. Click Color 1 and select an alternative color, such as dark blue or black.

9. To change the color of title bar text, click Font Color and select an alternative color, such as
off-white.

By default, the title bar text is white.
10. When done, click OK.

After a short delay, Windows is refreshed to use the new color scheme.
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Enabling Automatic Updates for critical Windows XP or 2003 updates

(Topic number: 7701)

Automatic Updates allow Microsoft to automatically determine what critical system updates are
needed for a system and to automatically download those updates. Only patches that Microsoft
deems as critical system updates are downloaded. Critical updates are downloaded to C:\Program
Files\WindowsUpdate\V4. When updates are downloaded, the Automatic Updates icon appears in
the Windows taskbar.

If a critical update has a negative effect on the system, the critical update can be uninstalled using
the Windows Add or Remove Programs dialog. Overall, Agfa believes that the risk to patient
information is far greater if the system is not patched and does not have the prescribed critical system
updates.

To enable Automatic Updates for critical Windows XP or 2003 updates
Open Control Panel.

Select System.
Switch to the Automatic Updates tab.

Select Download updates for me, but let me choose when to install them.

A e

To apply the changes, click OK.

Completing other initial Windows Vista
configurations

(Topic number: 49322)

We also recommend the following Windows configurations.

Switching to Windows Vista Control Panel classic view
(Topic number: 49271)

By default, Windows Vista uses different Control Panel categories than previous releases of Windows.
To make it easier to follow the procedures in this guide, change the Control Panel to display the
classic Windows categories instead.

To switch to Windows Vista Control Panel classic view
1. Open Control Panel.

2. In the left pane, under Control Panel, select Classic View.

The Control Panel window refreshes to display the same categories as in previous releases of
Windows. In the left pane, Classic View is selected.

Client Installation, Upgrade, and Configuration Guide—IMPAX 6.5.1 39
Agfa Company Confidential—Subject to Non-Disclosure Obligation



Overwriting Windows events as necessary
(Topic number: 47540)

IMPAX functions better when Windows events are overwritten as needed.

To overwrite Windows events as necessary
1. Open the Windows Administrative Tools and select Event Viewer.

2. Complete the following steps for each log under Windows logs and Application and Services
logs in the Event Viewer:

a. Right-click the log and select Properties.
b. Under Log Size, select Overwrite events as needed. Click OK.

Configuring Windows Explorer to show all files on Windows Vista
(Topic number: 49274)

We recommend that you display all available files in Windows Explorer.

To configure Windows Explorer to show all files on Windows Vista
1. Open Control Panel.

2. Select Folder Options.

3. Switch to the View tab.

4. Under Files and Folders, select Show hidden files and folders.
5. Clear the Hide extensions for known file types checkbox.

6. To save the changes, click OK.

Creating a temporary directory
(Topic number: 49277)

Having a temporary directory on the server can be useful for storing files that you do not have to
keep long-term.

To create a temporary directory
1. In Windows Explorer, select the C: drive.

2. Under Organize, select New Folder.

3. Rename the new folder temp.
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Disabling animation on Windows Vista
(Topic number: 67266)

To ensure optimal performance of the IMPAX Client, we recommend disabling animation (such as
fading in and out of dialog boxes, rounding of corners, and so on) on Windows Vista.

To disable animation on Windows Vista
Open Control Panel.

Select System.

Select Advanced system settings.

In the System Properties dialog, under Performance, click Settings.

In the Performance Options dialog, select Adjust for best performance.
When done, click OK.

When done, in the System Properties dialog, click OK.
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Changing the desktop colors on Windows Vista
(Topic number: 49283)

The default desktop colors for windows and title bars may be too bright for the lighting conditions
in reading rooms, particularly on diagnostic monitors. You can change these colors as needed.

To change the desktop colors on Windows Vista
Open Control Panel.

Select Personalization.

Select Window Color and Appearance.

Select Open classic appearance properties for more color options.
Click Advanced.

To change the background color of windows and dialogs, from the Item list, select Window.

AR o

By default, windows and dialogs are pure white. White is very bright on diagnostic monitors.
7. Click Color 1 and select an alternative color, such as gray or off-white.
8. To change the title bar color, from the Item list, select Active Title Bar.
Title bars are blue by default.
9. Click Color 1 and select an alternative color, such as dark blue or black.
10. When done, click OK.

After a short delay, Windows displays the new color scheme.
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Enabling Automatic Updates for critical Windows Vista updates
(Topic number: 113245)

Automatic Updates allow Microsoft to automatically determine what critical system updates are
needed for a system and to automatically download those updates. Only patches that Microsoft
deems as critical system updates are downloaded. Critical updates are downloaded to C:\Program
Files\WindowsUpdate\V4. When updates are downloaded, the Automatic Updates icon appears in
the Windows taskbar.

If a critical update has a negative effect on the system, the critical update can be uninstalled using
the Windows Add or Remove Programs dialog. Overall, Agfa believes that the risk to patient
information is far greater if the system is not patched and does not have the prescribed critical system
updates.

To enable Automatic Updates for critical Windows Vista updates
Open Control Panel.

Select System and Maintenance.
Select Windows Update.
In the left-hand pane, click Change Settings.

Select Download updates for me, but let me choose when to install them.

AN L

To apply the changes, click OK.

Completing other initial Windows 7 configurations

(Topic number: 104090)

We also recommend the following Windows configurations.

Configuring the Windows 7 Control Panel

(Topic number: 104095)

By default, Windows 7 uses different Control Panel categories than previous releases of Windows.
To make it easier to follow the procedures in this guide, change the Control Panel to display all
Control Panel items.

To configure the Windows 7 Control Panel
1. Open Control Panel.

2. From the View by list, select Small icons or Large icons (depending on user preference).

The Control Panel window refreshes to display each available Control Panel item.
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Configuring Windows Explorer to show all files on Windows 7
(Topic number: 104101)

We recommend that you display all available files in Windows Explorer.

To configure Windows Explorer to show all files on Windows 7
Open Control Panel.

Click Appearance and Personalization.

Select Folder Options.

Switch to the View tab.

Under Files and Folders, select Show hidden files, folders, and drives.
Clear the Hide extensions for known file types checkbox.

Click OK.

Ny w D=

Creating a temporary directory
(Topic number: 104107)

Having a temporary directory on the server can be useful for storing files that you do not have to
keep long-term.

To create a temporary directory
1. In Windows Explorer, select the C: drive.

2. Click New Folder.

3. Rename the new folder temp.

Disabling animation on Windows 7
(Topic number: 104110)

To ensure optimal performance of the IMPAX Client, we recommend disabling animation (such as
fading in and out of dialog boxes, rounding of corners, and so on) on Windows 7.

To disable animation on Windows 7
1. Open Control Panel.

Select System and Security.
Select System.
Select Advanced system settings.

In the System Properties dialog, under Performance, click Settings.

AL

In the Performance Options dialog, select Adjust for best performance.
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7. When done, click OK.
8. When done, in the System Properties dialog, click OK.

Changing the desktop colors on Windows 7
(Topic number: 104113)

The default desktop colors for windows and title bars may be too bright for the lighting conditions
in reading rooms, particularly on diagnostic monitors. You can change these colors as needed.

To change the desktop colors on Windows 7
. Open Control Panel.

1

2. Select Appearance and Personalization.

3. Select Window Color.

4. To change the background color of windows and dialogs, from the Item list, select Window.

By default, windows and dialogs are pure white. White is very bright on diagnostic monitors.

v

Click Color 1 and select an alternative color, such as gray or off-white.

6. To change the title bar color, from the Item list, select Active Title Bar.
Title bars are blue by default.

7. Click Color 1 and select an alternative color, such as dark blue or black.

8. When done, click OK.

After a short delay, Windows displays the new color scheme.

Enabling Automatic Updates for critical Windows 7 updates
(Topic number: 104367)

Automatic Updates allow Microsoft to automatically determine what critical system updates are
needed for a system and to automatically download those updates. Only patches that Microsoft
deems as critical system updates are downloaded. Critical updates are downloaded to C:\Program
Files\WindowsUpdate\V4. When updates are downloaded, the Automatic Updates icon appears in
the Windows taskbar.

If a critical update has a negative effect on the system, the critical update can be uninstalled using
the Windows Add or Remove Programs dialog. Overall, Agfa believes that the risk to patient
information is far greater if the system is not patched and does not have the prescribed critical system
updates.

To enable Automatic Updates for critical Windows 7 updates
1. Open the Control Panel.

2. Select System and Security.
3. Click Windows Update.
4. Click Change Settings.
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5. Select Download updates for me, but let me choose when to install them.

6. To apply the changes, click OK.

Changing the Windows taskbar settings

(Topic number: 7986)

To ensure that the IMPAX taskbar is always shown in the Image area, change the properties of the
Windows taskbar. Otherwise, some IMPAX features may get hidden behind the taskbar and thus
be inaccessible.

E Note:

Windows 7 has a translucent taskbar and this procedure can be skipped.

To change the Windows taskbar settings
1. Right-click the Windows taskbar and select Properties.

2. Clear the Keep the taskbar on top of other windows and Auto-hide the taskbar checkboxes.
3. Click OK.

Enabling active content for the Knowledge Base

(Topic number: 7700)

In Internet Explorer 7, all scripts on web pages are blocked by default. The IMPAX Knowledge Bases
use JavaScript for their Search functionality and to render glossary definition popups. If JavaScript
is blocked by the browser, when you view a Knowledge Base page, the definitions of the glossary
terms rendered with JavaScript cannot be viewed, and searching is impossible. Therefore, enable
active content.

Enabling local access to Knowledge Bases
(Topic number: 10017)

To access the Knowledge Base from the IMPAX Documentation DVD or from a local drive, you
must allow active content (including JavaScript) to run locally.

To enable local access to Knowledge Bases
1. In Internet Explorer, select Tools > Internet Options.

2. In the Internet Options dialog, switch to the Advanced tab.

3. Under Security, select the Allow active content from CDs to run on My Computer and the
Allow active content to run in files on My Computer checkboxes. Click OK.
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. For the changes to take effect, close and restart Internet Explorer.

You can now run the Knowledge Bases from the DVD or from a local drive.

Enabling remote access to Knowledge Bases

(Top

ic number: 10019)

Perform this task to access Knowledge Bases installed on a different server (such as the Application
Server).

To enable remote access to Knowledge Bases

[a—

10.

. In Internet Explorer, select Tools > Internet Options.

. In the Internet Options dialog, switch to the Security tab.
Select Trusted sites.

Click Sites.

In the Trusted sites dialog, if you are connecting to the Knowledge Base using http:// rather
than https://, clear the Require server verification (https:) for all sites in this zone checkbox.

We recommend that https:// be used.

In the Add this website to the zone field, type or paste the name of the Application Server that
the Knowledge Bases are installed on (https://server_name).

Click Add.
. Click Close.

. Click Custom Level. In the Security Settings dialog, under Scripting, ensure that Active scripting
is enabled. Click OK.

Click OK.

Configuring system languages

(Top

ic number: 10091)

You can display the IMPAX Client interface and Knowledge Base and the Administration Tools
interface in various languages:

Bulgarian Finnish Polish
Chinese (Simplified and Traditional) French Portuguese
Croatian German Romanian
Czech Hungarian Russian
Danish Italian Spanish
Dutch Norwegian Swedish
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English

The language used is based on the Windows regional settings. Some initial Windows configuration
is therefore required.

Configuring languages on Windows XP
(Topic number: 7966)

Information about Windows Vista language configuration can be found in Configuring languages
on Windows Vista (refer to page 50). Information about Windows 7 language configuration can be
found in Configuring languages on Windows 7 (refer to page 53).

To configure languages on Windows XP
. Install East Asian language files (refer to page 47) (if these languages are required)

[a—

2. Add all required languages (refer to page 48)
3. Select the region for the IMPAX Client (refer to page 49)
4. Optionally, enable language switching (refer to page 49) from the Windows taskbar

Installing East Asian language files
(Topic number: 49289)

Install East Asian files only if entering or receiving text in Chinese (Simplified or Traditional). To
install these files, you must be logged into Windows as an administrator-level user.

The East Asian files require approximately 230 MB hard disk space. Input Method Editors are also
installed for each language.

To install East Asian language files
Open Control Panel.

Select Regional and Language Options.
Switch to the Languages tab.
Under Supplemental language support, select the Install files for East Asian languages checkbox.

A

If Thai is required, also select the Install files for complex script and right-to-left languages
(including Thai) checkbox.

At the prompt, confirm the selection.
7. Click OK or Apply.

8. At the prompt, insert the Windows CD or browse to a network location where the files are
located.

*

The language files are installed.

9. Restart the computer.

When the computer restarts, log into Windows as an administrator-level user.
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Setting the Client interface language on Windows XP
(Topic number: 49292)

The IMPAX Client is available in 20 languages: Bulgarian, Chinese (Simplified), Chinese (Traditional),
Croatian, Czech, Danish, Dutch, English, Finnish, French, German, Hungarian, Italian, Norwegian,
Polish, Portuguese, Romanian, Russian, Spanish, and Swedish.

The interface language used is determined by the Language settings in Windows. To view the Client
in a different language than it is currently appearing in, you must change these settings. Add no
more languages than are required; each language is loaded into memory when the computer starts,
potentially affecting processing speed.

E Note:

If the user name contains special characters due to language settings, images cannot be
calibrated. Ensure that the system locale is changed to handle any special characters for a
particular language.

To set the Client interface language on Windows XP
Open Control Panel.

Select Regional and Language Options.

Switch to the Languages tab.

Under Text services and input languages, click Details.
Under Installed services, click Add.

From the Input language list, select the language to add.

Ny » D=

From the Keyboard Layout/IME list, select the keyboard type for this workstation. Click OK.

This option defines what keys are listed in the Keys list when defining IMPAX Client keyboard
shortcuts, when this language is used. (For Dutch and the East-Asian languages, English key
names are always used.)

8. To add other languages, repeat steps 5-7.

E Note:

It may be necessary to first download and install a language (MUI) pack using Windows
Update.

9. Under Default input language, select the language to use by default—the one required most
often.

10. Click OK.
11. Restart the station.
12. Loginto the IMPAX Client.

The language used for Client should now match the language selected in Control Panel.
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Selecting the region for the IMPAX Client
(Topic number: 49295)

While the IMPAX Client interface can be displayed in various languages, it should be set to one
region—normally, the one that matches its geographic location. The region setting affects how
numbers, dates, and currencies are displayed.

To select the region for the IMPAX Client
1. In the Regional and Language Options dialog, switch to the Regional Options tab.

2. From the Standards and formats list, select the region to use.
If you would like to choose your own format, click Customize.

3. Click Apply.

4. Switch to the Advanced tab.

5. To ensure that installation and updates work correctly, from the Language for non-Unicode
programs list, select the same language selected as the region.

6. Click Apply. Click OK.

Enabling language switching from the taskbar on Windows XP
(Topic number: 49298)

If this workstation will be used by speakers of various languages, it would be beneficial to make
language switching available from the taskbar.

To enable language switching from the taskbar on Windows XP
1. Open Control Panel.

Select Regional and Language Options.

Switch to the Languages tab.

Under Text services and input languages, click Details.

Under Preferences, click Language Bar.

Select the Show the Language bar on the desktop checkbox.

Select the Show additional Language bar icons in the taskbar checkbox.
Click OK three times.
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A floating Language Bar appears on the desktop.

9. To have the Language Bar appear on the taskbar instead, minimize the floating bar.

Users can then change the Windows language by clicking on the language icon in the taskbar and
selecting a different language.
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Co

nfiguring languages on Windows Vista

(Topic number: 49301)

Information on Windows XP language configuration can be found in Configuring languages on
Windows XP (refer to page 47). Information on Windows 7 language configuration can be found in
Configuring languages on Windows 7 (refer to page 53).

To configure languages on Windows Vista

1
2
3
4

. Install East Asian language files (refer to page 50) (if these languages are required).
. Add all required languages (refer to page 51).

. Select the region for the IMPAX Client (refer to page 52).

. Optionally, enable language switching (refer to page 52) from the Windows taskbar.

Installing East Asian language files

(Top

ic number: 49304)

Install East Asian files only if entering or receiving text in Chinese (Simplified or Traditional). The
files require approximately 230 MB hard disk space. Input Method Editors are also installed for each
language.

Toi
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Note:

The Display Language section is only available if you have already installed a Language
Interface Pack (LIP) or your edition of Windows Vista supports Multilingual User Interface
Pack (MUI). MUI packs are only available for Windows Vista Ultimate and Windows Vista
Enterprise.

nstall East Asian language files
Log into Windows as an administrator.

Open Control Panel.

Select Regional and Language Options.

Switch to the Keyboard and Languages tab.

Under Supplemental language support, select the Install files for East Asian languages checkbox.

If Thai is required, also select the Install files for complex script and right-to-left languages
(including Thai) checkbox.

At the prompt, confirm the selection.
. Click OK or Apply.

. At the prompt, insert the Windows CD in the CD-ROM drive or browse to a network location
where the files are located.

The language files are installed.
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10. Restart the computer.

Adding all required languages and selecting a default language on Windows Vista
(Topic number: 49307)

If you expect IMPAX to be accessed in more than one language on this workstation, you must add
each language through the Windows Control Panel. Add no more languages than are required; each
language is loaded into memory when the computer starts, potentially affecting processing speed.

E Note:

If the user name contains special characters due to language settings, images cannot be
calibrated. Ensure that the system locale is changed to handle any special characters for a
particular language.

To add all required languages and select a default language on Windows Vista
Open Control Panel.

Select Regional and Language Options.
Switch to the Keyboard and Languages tab.
Click Change keyboards.

Switch to the General tab.

SANER L

Under Default input language, select the language to use by default—the one required most
often.

Under Installed services, click Add.

>

8. From the language list, select the language to add.

% Note:

It may be necessary to first download and install a language (MUI) pack using Windows
Update.

9. From the Keyboard Layout/IME list, select the keyboard type for this workstation. Click OK.

This option specifies the keys in the Keys list that define IMPAX Client keyboard shortcuts
when this language is used. (For Dutch and the East-Asian languages, English key names are
always used.)

10. To add other languages, repeat steps 5-7.
11. Click OK.
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Selecting the region for the IMPAX Client
(Topic number: 49310)

While the IMPAX Client interface can be displayed in various languages, it should be set to one
region—normally, the one that matches its geographic location. The region setting affects how
numbers, dates, and currencies are displayed.

To select the region for the IMPAX Client
1. In the Regional and Language Options dialog, switch to the Formats tab.

2. From the Current format list, select the region to use.

If you would like to choose your own format, click Customize this format.
3. Click Apply.
4. Switch to the Administrative tab.

5. To ensure that installation and updates work correctly, in the Language for non-Unicode
programs area, verify the Current language for non-Unicode programs is the same language
selected in step 2.

6. Click Apply. Click OK.

Enabling language switching from the taskbar on Windows Vista
(Topic number: 49313)

If this workstation will be used by speakers of various languages, make language switching available
from the taskbar.

To enable language switching from the taskbar on Windows Vista
Open Control Panel.

Select Regional and Language Options.

Switch to the Keyboards and Languages tab.

Click Change keyboards.

In the Text Services and Input Languages dialog, switch to the Language Bar tab.
In the Language Bar area, select Floating On Desktop.

Select the Show additional Language bar icons in the taskbar checkbox.

Click OK twice.

® N AU w D=

A floating Language Bar appears on the desktop.
9. To have the Language Bar appear on the taskbar instead, minimize the floating bar.

To change the Windows language, users can click the language icon in the taskbar and select
a different language.
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Configuring languages on Windows 7
(Topic number: 104328)

Information on Windows XP language configuration can be found in Configuring languages on
Windows XP (refer to page 47). Information on Windows Vista language configuration can be found
in Configuring languages on Windows Vista (refer to page 50).

To configure languages on Windows 7
1. Install East Asian language files (refer to page 53) (if these languages are required).
2. Add all required languages (refer to page 53).
3. Select the region for the IMPAX Client (refer to page 54).
4. Optionally, enable language switching (refer to page 54) from the Windows taskbar.

Installing East Asian language files
(Topic number: 104334)

Install East Asian files only if entering or receiving text in Chinese (Simplified or Traditional).
Windows 7 Multilingual User Interface (MUI) files require a license to be used. Contact Microsoft
to obtain a license for East Asian files.

Adding all required languages and selecting a default language on Windows 7
(Topic number: 104337)

If you expect IMPAX to be accessed in more than one language on this workstation, you must add
each language through the Windows Control Panel. Add no more languages than are required; each
language is loaded into memory when the computer starts, potentially affecting processing speed.

% Note:

If the user name contains special characters due to language settings, images cannot be
calibrated. Ensure that the system locale is changed to handle any special characters for a
particular language.

To add all required languages and select a default language on Windows 7
Open Control Panel.

Select Region and Language.

Switch to the Keyboard and Languages tab.
Click Change keyboards.

Switch to the General tab.

AL

Under Default input language, select the language to use by default—the one required most
often.
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7. Under Installed services, click Add.
8. From the language list, expand the language to add.

E Note:

It may be necessary to first download and install a language (MUI) pack via Windows
Update.

9. Expand Keyboard.
10. From the Keyboard list, select the keyboard type for this workstation. Click OK.

This option specifies the keys in the Keys list that define IMPAX Client keyboard shortcuts
when this language is used. (For Dutch and the East-Asian languages, English key names are
always used.)

11. To add other languages, repeat the previous three steps.

12. Click OK.

Selecting the region for the IMPAX Client
(Topic number: 104343)

While the IMPAX Client interface can be displayed in various languages, it should be set to one
region—normally, the one that matches its geographic location. The region setting affects how
numbers, dates, and currencies are displayed.

To select the region for the IMPAX Client
1. In the Region and Language dialog, switch to the Formats tab.

From the Format list, select the region to use.
Click Apply.

Switch to the Administrative tab.

A

To ensure that installation and updates work correctly, under Language for non-Unicode
programs, verify that the Current language for non-Unicode programs is the same as the region
selected in step 2.

6. Click Apply. Click OK.

Enabling language switching from the taskbar on Windows 7
(Topic number: 104355)

If this workstation will be used by speakers of various languages, make language switching available

from the taskbar.

To enable language switching from the taskbar on Windows 7
1. Open Control Panel.

2. Select Region and Language.
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Switch to the Keyboards and Languages tab.

Click Change keyboards.

Switch to the Language Bar tab.

Under Language Bar, select Floating On Desktop.

Select the Show additional Language bar icons in the taskbar checkbox.
Click OK twice.

A floating Language Bar appears on the desktop.

. To have the Language Bar appear on the taskbar instead, minimize the floating bar.

To change the Windows language, users can click the language icon in the taskbar and select
a different language.

Configuring the smart card removal behavior setting

(Topic number: 67001)

The smart card removal behavior setting tells Windows how to react when users remove their smart
cards from the reader.

To configure the smart card removal behavior setting

1.

*

8.

Open the Windows Administrative Tools.

2. Select Domain Security Settings.
3. Expand the Local Policies folder.

4.
5

Select Security Options.

. From the right-hand pane, right-click Interactive logon: Smart card removal behavior and

select Properties.

Select Define this policy setting.

. From the list, select one of the following choices:

+ No Action—Windows takes no action, which causes the user to remain logged into the
IMPAX Client. We do not recommend this option.

* Lock Workstation—Windows locks the workstation but does not log the user out of the
IMPAX Client. If the IMPAX Client remains idle for a certain period of time, the user is
logged out automatically.

* Force Logoff—Windows forces the user to log out of both the IMPAX Client and
Windows.

Click OK.
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Installing the IMPAX
Client software

The following information explains how to install the IMPAX Client software, including setting up
an Installation Server. It also explains how to automate the installation of the IMPAX Client software.

IMPAX Client installation types: Reference

(Topic number: 46790)

The following provides an overview of the different types of installation available for the IMPAX
Client.

+ IMPAX Client Installation CD—The default InstallShield package provided by Agfa.

+ Installation Server—A web page with links to each installer and installation instructions that
allow users to download and install Client software and updates.

+ Portable installation CD—A portable IMPAX Client installation CD that contains all
prerequisite and IMPAX Client software. The script can be customized to identify the
Application Server and authentication type, making the installation silent.

+ Silent or Automated installation—A command line process that installs the IMPAX Client
using the default IMPAX Client installation CD or IMPAX Installation Server silent, or
automated. The various installation settings and their values can be specified eliminating the
need for any user input during the installation.

+ Automatic Client Updates—Background updates of the IMPAX Client that are automatically
sent to each IMPAX Client workstation.
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Installing the IMPAX Installation Server

(Topic number: 7773)

You can choose to install the IMPAX Client software onto each workstation from CD, in which case
you can skip this procedure and continue with Installing the IMPAX Client (refer to page 75).
Alternatively, you can set up an IMPAX Installation Server by running the
IMPAXInstallationServerSetup.exe on a Windows-based server.

Setting up the Installation Server makes it easier to install the Client software from a central website.
You can also use it to install updates to the Client software when they become available throughout
the site and to remote Clients. (Details regarding how to update Clients are provided in Configuring
automatic Client updates (refer to page 81).)

You may choose to install the Installation Server program on an IMPAX Application Server (in
which case you can continue with Running the IMPAX Installation Server package (refer to page 61))
or on a separate, dedicated Windows-based server.

E Note:

If your site has a large number of IMPAX Clients, or they are regularly updated, using an
Application Server as an Installation Server may affect the performance of Clients connected
to that Application Server. This is because the Clients all check for a new version every 30
minutes and, although staggered, performance issues have been reported when many Clients
are downloading the new IMPAX Client software.

Therefore, we recommend:

+ Using a third-party software distribution application (for example, Microsoft SMS or Altiris)
to avoid saturation of the Application Server. Consult your regional Agfa representative for
options.

+ Placing the Installation Server on a dedicated server.

If you choose to install the IMPAX Installation Server package on a dedicated server, use the Web
Server Certificate Wizard to create a certificate request to submit to a trusted certificate authority,
and install the certificate. You must install the SSL certificate on the dedicated server before installing
the IMPAX Installation Server package.

The Installation Server Setup package contains:
* The installers (or links) for the IMPAX Client prerequisites:
+ .NET Framework 3.5 SP1

* Visual C++ 9.0 SP1

¢ DirectX

« The IMPAX Client Installer
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*+ A web page with links to:
+ IMPAX Client system requirements

+ IMPAX Client installation instructions (available in 19 languages)
+ Links to the IMPAX Client Installer

+ Links to the individual perquisites

Installing an SSL certificate on a dedicated server
(Topic number: 7786)

Important!

This procedure does not need to be completed if the IMPAX Installation Server is being
installed on an IMPAX Application Server.

The IMPAX Installation Server cannot be used without an SSL certificate. Purchase a 128-bit encrypted
SSL certificate from a trusted Certificate Authority to guarantee the security of users accessing IMPAX
using a remote Client.

Creating an SSL certificate request
(Topic number: 51218)

Generate a certificate request that can be submitted to a trusted certificate authority. If you already
have the SSL Certificate from the certificate authority, skip this topic and go to Importing an SSL
certificate in the Security Wizard.

To create an SSL certificate request

1. On the desktop, select Start > Administrative Tools > Internet Information Services (IIS)
Manager.

2. In the Internet Information Services (IIS) Manager dialog, expand local computer > Web
Sites.

Right-click Default Web Site and select Properties.

In the Default Web Site Properties dialog, switch to the Directory Security tab.
Click Server Certificate.

In the Welcome to the Web Server Certificate Wizard dialog, click Next.

In the Server Certificate dialog, select Create a new certificate. Click Next.

® N AU oW

In the Delayed or Immediate Request dialog, select Prepare the request now, but send it later.
Click Next.

9. Inthe Name and Security Settings dialog, in the Name field, type a name for the new certificate.
From the Bit length list, select 1024. Click Next.
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10.

11.

12.
13.

14.

15.
16.
17.
18.

In the Organization Information dialog, type the name of your Organization and
Organizational unit. Click Next.

In the Your Site’s Common Name dialog, type the fully qualified domain name of the machine
if it is not already present by default.

The fully qualified domain name consists of a host, domain name, and top-level domain. For
example, machinename.networkname.hospitalname.com. You should be able to ping the fully
qualified domain name.

Click Next.

In the Geographical Information dialog, type or select the Country/Region, State/province,
and City/locality information for your site. Click Next.

In the Certificate Request File Name dialog, type a location and name for the request file.

The default file name is c:\certreq.txt. To avoid overwriting certificate request files, ensure that
each request file has a unique name.

Click Next.
In the Request File Summary dialog, confirm that all the information is correct. Click Next.
In the Completing the Web Server Certificate Wizard dialog, click Finish.

Open the certificate request file and copy the information in the file to the Clipboard so that
it can pasted into the certificate authority’s online application form.

Viewing the list of certificate authorities in Internet Explorer
(Topic number: 50237)

Use a trusted certificate authority when requesting an SSL certificate.

To view the list of certificate authorities in Internet Explorer

1.

AR

Open Internet Explorer.

Select Tools > Internet Options.

Switch to the Content tab.

Under Certificates, click Certificates.

Switch to the Trusted Root Certification Authorities tab.

The list of certificate authorities recognized by Internet Explorer is displayed.

Tip:

Trusted certificate authorities include Verisign http://www.verisign.com, Thawte
http://mww.thawte.com, Entrust http://www.entrust.com, Comodo http://www.comodogroup.com,
and Globalsign http://www.globalsign.com. These certificate authorities are already trusted
by Internet Explorer.
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If using your own certificate authority, on each Client, ensure that Internet Explorer is configured
as follows: the Check for publisher’s certificate revocation option is selected and the
Check for server certificate revocation option is cleared.

Submitting a certificate request to a certificate authority
(Topic number: 11411)

You cannot use a dedicated IMPAX Installation Server without an SSL certificate. Purchase a 128-bit
encrypted SSL certificate from a trusted Certificate Authority to guarantee security.

To submit a certificate request to a certificate authority
1. Create an SSL certificate request.

2. Open a web browser and go to the website of a certificate authority.

For a list of trusted certificate authorities, consult Viewing the list of certificate authorities in
Internet Explorer (refer to page 59).

3. Purchase a 128-bit encrypted SSL certificate by following the instructions on the certificate
authority’s website.

The exact steps may vary, depending on which trusted certificate authority is used.

After you have received the SSL certificate from the certificate authority, import and assign it.

Importing an SSL Certificate
(Topic number: 51227)

Once you have received an SSL certificate from the certificate authority, you must import it onto
the computer.

To import the SSL certificate

1. On the desktop, select Start > Administrative Tools > Internet Information Services (IIS)
Manager.

2. In the Internet Information Services (IIS) Manager dialog, expand local computer > Web
Sites.

Right-click Default Web Site and select Properties.

In the Default Web Site Properties dialog, switch to the Directory Security tab.
Click Server Certificate.

On the Web Server Certificate Wizard Welcome screen, click Next.

N o W

In the Pending Certificate Request dialog, select Process the pending request and install the
certificate. Click Next.

8. In the Process a Pending Request dialog, type the location and file name for the pending
certificate. Click Next.
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10.
11.
12.

13.
14.

. In the SSL Port dialog, in the SSL port this web site should use field, accept the default of 443.

Click Next.
In the Certificate Summary dialog, confirm that all the information is correct. Click Next.
In the Completing the Web Server Certificate Wizard dialog, click Finish.

Open the Default Web Site Properties dialog, if it is not already open, and switch to the
Directory Security tab.

Click View Certificate.

In the Certificate dialog, switch to the General tab, and confirm that the statement “You have
a private key that corresponds to this certificate” exists.

You can now install the IMPAX Installation Server package on this Server.

Running the IMPAX Installation Server package

(Topic number: 7758)

CAUTION!

Do not install the IMPAX Installation Server on a standalone IMPAX workstation (a workstation
running the AS300, Application Server, and Client software).

The following explains how to install the IMPAX Installation Server to use as a distribution tool for
Client installations and updates.

To run the IMPAX Installation Server package

1.

From the IMPAX Client CD or a network location, run IMPAXInstallationServerSetup.exe.

A Preparing to install message appears.

. On the Welcome to the InstallShield Wizard for IMPAX Installation Server screen, click Next.

. To install the application into C:\Inetpub\wwwroot\ClientInstaller, on the Destination Folder

screen, click Next.
or

To install the application to another location, click Change. In the Change Current Destination
Folder dialog, browse for the directory location to install into and click OK. On the Destination
Folder screen, click Next.

On the Ready to Install the Program screen, click Install.

The first installer runs.

. On the Installation Wizard Completed screen, click Finish.

Another installer starts. (It may start before the first one finishes.) The second one opens a
command prompt that creates a manifest file.

. On the second Installation Wizard Completed screen, click Finish.

In the folder where the application was installed, several subfolders appear, including:
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* de, en, es, fr, and other two-letter country codes—each containing a web page that users
can point to for a link to the executable and instructions for installing the IMPAX Client.
A file folder exists for each language that IMPAX supports. (More details are available in
Configuring system languages (refer to page 46).)

+ redist—contains the NET Framework installers.

* installer—contains the ImpaxClientSetup.exe, the IMPAX Client installation software.

For the updater service, which allows all installed Clients to receive automatic updates, public and
private key pairs are installed in C:\Program Files\Agfa\IMPAX Client, as described in Configuring
automatic Client updates (refer to page 81).

Accessing the Client Installer page
(Topic number: 56669)

The Client Installer page contains instructions for installing the IMPAX Client. These instructions
are available in 24 languages. Details on how to change the language are available in Changing the
default language of the Client Installer page (refer to page 86).

To access the Client Installer page
1. In the address field of a browser, type:

https://<install_server_name>/clientinstaller

Where <install_server_name> is the name of the IMPAX Installation Server.

Creating an IMPAX Client installation CD

(Topic number: 10048)

ﬂ CAUTION!

To create an IMPAX Client installation CD, you must perform these steps on a computer with
a CD burner installed.

Use the following instructions to create a portable IMPAX Client installation CD. This CD contains
all prerequisite software and the IMPAX Client installation package. You can also customize the
C:\client\impax-client-setup_impax65Se_<build_number>\Install CD\script.vbs file (default location)
to identify the Application Server name and authentication type, making the installation silent.
Before creating the CD, contact your Agfa representative for the files required to create the CD.

To create an IMPAX Client installation CD
1. Contact your Agfa representative for the files required to create the CD.

2. From the IMPAX Client CD-ROM or a network location, navigate to \InstallCD.
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3. Copy the InstallCD folder to the computer hard drive.

4. Open the InstallCD folder on the hard drive and open the script.vbs file with a text editor such
as Notepad.

5. Modify the appServerName = "" value to include the fully qualified domain name of the
Application Server for the cluster. For example:
appServerName = "machinename.networkname.hospitalname.com"

6. Modify the authenticationType = "" value to identify how users will authenticate in IMPAX.
Possible values include:

authenticationType = "1" for Basic IMPAX Authentication
authenticationType = "2" for Windows Authentication
authenticationType = "3" for Smart Card Authentication
7. Save and close the script.vbs file.
8. Copy the contents of the InstallCD folder to a CD.

9. To start the automatic installation, insert the IMPAX Client Installation CD into a workstation
CD-ROM drive.

Installing the IMPAX Client

(Topic number: 7776)

Important!

If installing the Client as part of the upgrade process, .NET Framework 3.5 SP1 must be
installed prior to starting the Client installation.

The following explains how to install IMPAX Client using the default InstallShield package. An
alternative is to automate the installation through a batch file or software distribution tool.
Instructions on installing IMPAX Client that way are provided in Enabling automated installation
of the IMPAX Client software from a command prompt (refer to page 65) and Installing the IMPAX
Installation Server (refer to page 57).

E Note:

To install the IMPAX Client, you must be logged in as a user in a Administrators role that has
permissions to the Windows Services.

To install the IMPAX Client

1. From the IMPAX Client CD or the IMPAX Client Installation web page
(https://install_server_namel/clientinstaller/language_code), start the IMPAX Client installation
program, IMPAXClientSetup.exe.

2. If a File Download dialog appears, click Open or Run.
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APreparing to Install message appears.
If on Windows Vista, a cscript.exe prompt may appear. To run it, click OK.
3. If a prompt appears about downloading and installing missing components, click OK.

4. Follow the prompts to download and install Microsoft .NET Framework 3.5, Microsoft NET
Framework 3.5 SP1, or all.

E Note:

After installing a component, the installer may stop running or you may receive an
Installation is not yet conpl ete message. In either case, rerun the
IMPAXClientSetup.exe program.

Depending on network speed, downloading and installing the Microsoft NET Framework can
take over 30 minutes.

For the .NET Framework 3.5 install, after the download, agree to the installation, accept the
license agreement, and after the installation is complete click OK. If prompted, restart the
computer.

If you do not have a live Internet connection, the downloading will not work. Instead, install
the Microsoft .NET Framework 3.5 from the Client Installer server
(https://install_server_name/clientinstaller/redist/dotnetfx35.exe).

For the .NET Framework 3.5 SP1 install, after the download, if prompted to start the installation,
click OK. If prompted, restart the computer.

5. On the Welcome to the InstallShield Wizard for IMPAX Client screen, click Next.

6. On the License Agreement screen, read the license agreement. If you agree, select I accept the
terms in the license agreement. Click Next.

7. To install the application into C:\Program Files\Agfa\IMPAX Client, on the Destination Folder
screen, click Next.

or

To install the application to another location, click Change. In the Change Current Destination
Folder dialog, browse for the directory location to install into and click OK. On the Destination
Folder screen, click Next.

8. On the IMPAX Application Server screen, in the Get or confirm application server name field,
type the fully qualified domain name of the Application Server to use. Click Next.

A fully qualified domain name is the full name of a system, including its local host name and
complete domain name. For example, if the Application Server is called radserver, it is on the
network domain called radnet, and radnet is within the healthorg.com domain, the name to
type would be radserver.radnet.healthorg.com.

9. On the IMPAX Login Type screen, select the appropriate authentication method: Windows,
IMPAX, or Smart Card.

+ Windows Authentication—Logs into IMPAX using the Windows session credentials
after launching the IMPAX Client or logging in with a Windows smart card.
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+ IMPAX Authentication—Logs into the IMPAX Client separately from Windows. (If
unsure of which option to select, use IMPAX Authentication.)

+ Smart Card Authentication—Logs into the IMPAX Client with a smart card in the
National Health Service (NHS) environment only.
10. Click Next.
11. On the Ready to Install the Program screen, click Install.
The program is installed.
12. On the InstallShield Wizard Completed screen, click Finish.

The IMPAX Client software is installed. You do not have to restart the computer.

Enabling automated installation of the IMPAX
Client software from a command prompt

(Topic number: 7802)

Installation of the IMPAX Client can be completely silent, or automated. This can simplify an IMPAX
Client rollout, and eliminates the need for any user input during the installation.

Through a line command issued on the client workstation, the various installation settings and their
values can be specified; otherwise, defaults are applied. The command can be distributed to users
through a batch file, or through a software distribution tool such as Microsoft Systems Management
Server (SMS).

To enable automatic installation of the IMPAX Client software from a command line
1. Atacommand prompt, type

ImpaxClientSetup.exe /S /v"setting=value... /quiet"
where /S suppresses the initial InstallShield Wizard screen,
and /v allows for the specification of installation settings and their values,

and /quiet suppresses all the installation screens.

Installation setting Description Value

ALLUSERS Specifies installation Default—All users, if person installing has
for current user only, administrative privileges; otherwise,
or all machine users current user

NULL—Current user

1—All users, if person installing has
administrative privileges; otherwise,
installation fails
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Installation setting Description

USERNAME User name

COMPANYNAME Organization name

INSTALLDIR Root installation
directory

APPSERVER Application Server
name

AUTHENTICATION_TYPE Authentication mode

Value

2—All users, if person installing has
administrative privileges; otherwise,
current user

Any other value—default is applied

Default—Name registered during
Windows installation

Default—Name registered during
Windows installation

Default—C:\Program Files\Agfa\IMPAX
Client

Default—blank

Default—IMPAX authentication

1—IMPAX authentication screen prompts
user for user ID and password

2—User ID and password of current
Windows or Windows smart card user is
used to log into IMPAX

3—Smart card authentication requires the
user to have an NHS smart card to log into
IMPAX

Any other value—Default is applied

Spacing rules for installation settings
(Topic number: 7757)

When specifying installation settings values using the /v flag, certain rules regarding spacing of the

settings must be followed.

+ Leave no spaces between the /v flag and its settings. For example:

[V"'ALLUSERS=2" (valid)
/v "ALLUSERS=2" (invalid)

+ Separate each setting and value pair by a space from another setting and value pair. For example:

/v"ALLUSERS=2 USERNAME=Peter" (valid)
/v"'ALLUSERS=2USERNAME=Peter" (invalid)

* Delimit spaces within a value with a \". For example:

[v"USERNAME=\"Peter Smith\"" (valid)
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/V'"'USERNAME=Peter Smith" (invalid)

Examples of installation settings
(Topic number: 7801)

The following contains example combinations of settings to be used at the command line. Following
each installation command is a table detailing what each value changes.

ImpaxClientSetup.exe /v'APPSERVER=radserver.radnet.healthorg.com ALLUSERS=NULL"

Initial InstallShield Wizard screen displayed?
All installation screens displayed?

User name

Organization name

Installation type

Installation directory

Application server

Authentication mode

Yes

Yes

Agfa

Agfa

Current user

C:\Program Files\Agfa\IMPAX Client
radserver.radnet.healthorg.com

IMPAX authentication

ImpaxClientSetup.exe /v'INSTALLDIR=\"C:\Rad Tools\Agfa\IMPAX Client\"
APPSERVER=radserver.radnet.healthorg.com /quiet"

Initial InstallShield Wizard screen displayed?
All installation screens displayed?

User name

Organization name

Installation type

Installation directory
Application server

Authentication mode

Yes
No
Agfa
Agfa

All users, if person installing has
administrative privileges; otherwise, current
user

C:\Rad Tools\Agfa\IMPAX Client
radserver.radnet.healthorg.com

IMPAX authentication

ImpaxClientSetup.exe /S /v"APPSERVER=radserver.radnet.healthorg.com

AUTHENTICATION_TYPE=2"

Initial InstallShield Wizard screen displayed?
All installation screens displayed?
User name

Organization name

No
Yes
Agfa
Agfa
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Installation type

Installation directory
Application server

Authentication mode

All users, if person installing has

administrative privileges; otherwise, current

user
C:\Program Files\Agfa\IMPAX Client
radserver.radnet.healthorg.com

Windows authentication
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Upgrading the IMPAX
Client

Before installing the new version of the IMPAX Client, you must remove the previous IMPAX 5.2
or 5.3 releases of IMPAX (removing IMPAX 6.2 or later software is optional) and Oracle 9.2 (if
installed) from your workstations.

Manually upgrading the IMPAX Client from IMPAX
5.20r5.3

(Topic number: 51453)

Before upgrading the IMPAX Client, ensure that IMPAX 5.2 or 5.3 Select wizards information is
exported to the users.xml file. For more details, consult the IMPAX 6.5.1 Preparing to Upgrade
Guide—IMPAX 4.5, 5.2, 5.3, or WEBI000 to IMPAX 6.5.1.

Perform the following steps when upgrading an IMPAX 5.2 or 5.3 Client workstation to IMPAX
6.5.1.

E Note:

If you have many Clients to install, we recommend considering a third-party software distribution
application (for example, Microsoft SMS or Altiris ) to automate the add/removal of software.

To manually upgrade the IMPAX Client from IMPAX 5.2 or 5.3 to IMPAX 6.5.1

1. Verify the hardware and operating system are compatible with IMPAX 6.5.1. (refer to page
71)

2. Uninstall the IMPAX Client. (refer to page 72)
3. Uninstall the IMPAX 5.2 or 5.3 documentation. (refer to page 73)
4. Uninstall the Oracle client. (refer to page 75)
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10.
11.

Run the Microsoft .NET Framework 3.5 SP1 installer package. (refer to page 71)

. Install the IMPAX 6.5.1 Client. (refer to page 56)

This step explains how to install IMPAX Client using the default InstallShield package on each
station. An alternative is to automate the installation through a batch file or third-party software
distribution tool. Instructions on installing IMPAX Client that way are provided in Enabling
automated installation of the IMPAX Client software from a command prompt (refer to page 65)
and Installing the IMPAX Installation Server (refer to page 57).

Verity the IMPAX Client upgrade. (refer to page 77)

Configure the IMPAX Client. (refer to page 80)

Create standard worKklists from the users.xml file. (refer to page 78)
Change the permissions for migrated teaching files. (refer to page 78)

Install any related software. (refer to page 91)

Manually upgrading the IMPAX Client from IMPAX
6.2 or later

(Topic number: 51459)

Perform the following steps when upgrading an IMPAX 6.2 or later Client workstation to IMPAX

6.5.1.

Important!

You must update existing Clients to the .NET Framework 3.5 SP1 before installing the IMPAX
6.5.1 Client.

To manually upgrade the IMPAX Client from IMPAX 6.2 or later to IMPAX 6.5.1

1.

Verify the hardware and operating system are compatible with IMPAX 6.5.1. (refer to page
71)

. Optionally, manually uninstall the IMPAX Client. (refer to page 104)
. Run the Microsoft NET Framework 3.5 SP1 installer package. (refer to page 71)

Install the IMPAX 6.5.1 Client. (refer to page 56)

This step explains how to install IMPAX Client using the default InstallShield package on each
station. An alternative is to automate the installation through a batch file or third-party software
distribution tool. Instructions on installing IMPAX Client that way are provided in Enabling
automated installation of the IMPAX Client software from a command prompt (refer to page 65)
and Installing the IMPAX Installation Server (refer to page 57).

. Verify the IMPAX Client upgrade. (refer to page 77)
. Configure any new functionality in the IMPAX Client. (refer to page 80)

Install any related software. (refer to page 91)
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Verifying hardware and operating system
compatibility with IMPAX 6.5.1

(Topic number: 7992)

Ensure that any existing IMPAX 5.2 and 6.2 or later Client workstations meet the minimum
requirements for hardware and software before upgrading the workstation to IMPAX 6.5.1.

Detailed instructions on installing the external software required for IMPAX Client workstations
are available in Installing external software (refer to page 21) or the documentation provided with
the software.

You must install and configure the software in the order listed in External software: Order of installation
tasks (refer to page 21).

Running the Microsoft .NET Framework 3.5 SP1
installer package

(Topic number: 107096)

Important!

.NET Framework 3.5 SP1 must be installed prior to starting the Client installation. We
recommend using Group Policies or SMMS to download and install .NET Framework 3.5 SP1.
However, if these methods are not available, the .NET Framework 3.5 SP1 installer package
is available.

The Microsoft .NET Framework 3.5 SP1 installer package is a modified version of the IMPAX
Installation Server. It distributes the .NET upgrade to Client workstations throughout the site and
to remote Clients.

A week prior to upgrading the IMPAX Client software, run the installer package on the Application
Server or a dedicated Windows-based server. We recommend running the installer package during
the site's off-hours as downloading and installing the Microsoft .NET framework can take over 30
minutes, depending on network speed.

If you choose to run the installer package on a dedicated server that does not already have the IMPAX
Installation Server installed and using https mode, use the Web Server Certificate Wizard to create
a certificate request to submit to a trusted certificate authority, and install the certificate. You must
install the SSL certificate on the dedicated server (refer to page 58) before running the installer
package. If using http mode, you do not need to install the SSL certificate. For more details on how
to get clients to point to the correct location of the Installation Server, see Installing the IMPAX
Installation Server (refer to page 57).
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Note:

The PACS Client Updater service downloads and installs the .NET Framework 3.5 SP1. The
services run as administrator, so you do not have to log in as the administrator user.

To run the Microsoft .NET Framework 3.5 SP1 installer package

1.

From the IMPAX Client CD or a network location, run
IMPAXInstallationServer_DotNet35Updater.exe.

On the Welcome to the InstallShield Wizard for Agfa IMPAX Installation Server - .NET 3.5
SP1 Updater screen, click Next.

. To install the application into C:\Inetpub\wwwroot\ClientInstaller, on the Destination Folder

screen, click Next.
or

To install the application to another location, click Change. In the Change Current Destination
Folder dialog, browse for the directory location to install into and click OK. On the Destination
Folder screen, click Next.

. On the Ready to Install the Program screen, click Install.

The installer runs.

. On the Installation Wizard Completed screen, click Finish.

Manually uninstalling the IMPAX 5.2 or 5.3 Client
software

(Topic number: 51525)

IMPAX 5.2 or 5.3 Client software must be uninstalled before the IMPAX 6.5.1 Client software can
be installed.

To manually uninstall the IMPAX 5.2 or 5.3 Client software

1.
2.

Open Control Panel.

On Windows 2003 servers, select Add or Remove Programs. On Windows 2008 servers, select
Programs and Features.

. On Windows 2003 servers, under Currently installed programs, select IMPAX Client ES and

click Remove.
or
On Windows 2008 servers, select IMPAX Client ES and click Uninstall.
Atthe Are you sure you want to remove this progran? prompt, click Yes.

If a Files Not Removed dialog opens, to remove the remaining files, click Yes.

. At the Uninstall Successful message, click OK.
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7. Restart the computer.

8. After the computer has restarted, verify that the C:\mvf directory has been deleted. If the
directory is still present, delete it.

Manually uninstalling the IMPAX 6.2 or later Client
software (optional)

(Topic number: 7752)

Important!

This procedure is optional. You should not have to uninstall the IMPAX 6.2 or later Client
software prior to installing the IMPAX 6.5.1 Client software. However, if the IMPAX Client is
installed on Windows Vista, we recommend uninstalling it prior to the installation of the new
version.

The following procedure removes the IMPAX Client software but not any integrated software (such
as the Orthopaedic Application, TalkStation, or Volume Viewing).

To manually uninstall the IMPAX 6.2 or later Client software
1. If running, log out of the IMPAX Client and close the Login window.

Open Control Panel.
Select Add or Remove Programs.
Under Currently installed programs, select AGFA IMPAX Client build_number.

Click Remove.

AL

When asked to confirm the removal, click Yes.

A Preparing to remove dialog opens, then the IMPAX Client software is uninstalled.

Removing the IMPAX 5.2 or 5.3 Client Knowledge
Base

(Topic number: 58578)

If the IMPAX 5.2 or 5.3 Client Knowledge Base is installed, you must uninstall it before upgrading.

To remove the IMPAX 5.2 or 5.3 Client Knowledge Base
1. Open Control Panel.

2. On Windows 2003 servers, select Add or Remove Programs.

or
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On Windows 2008 servers, click Programs and Features.

On Windows 2003 servers, select IMPAX Client Knowledge Base 5.2 or IMPAX Client
Knowledge Base 5.3 and click Change/Remove.

or

On Windows 2008 servers, select IMPAX Client Knowledge Base 5.2 or IMPAX Client
Knowledge Base 5.3 and click Uninstall.

In the Confirmation dialog, click OK.

If also uninstalling the IMPAX Server Knowledge Base, in the Maintenance Complete dialog,
select No, I will restart my computer later. Otherwise, select Yes, I want to restart my computer
now and click Finish.

. If you restarted the computer, log into Windows as an administrator-level user.

To remove any translations of the IMPAX 5.2 or 5.3 Client Knowledge Base, delete the
C:/impax/documents/client/translations directory.

Removing System DSN entries for any Oracle ODBC
driver

(Topic number: 57993)

CAUTION!

This step is unnecessary if you are upgrading an IMPAX 6.2 or later Client workstation.

You must perform two procedures to remove the Oracle 9.2 Client. First, you must remove the
System DSN entries for any Oracle ODBC driver in the ODBC Data Source Administrator. Second,
you must uninstall the Oracle 9.2 Client software.

To remove the System DSN entries for any Oracle ODBC driver

1.

AN

Open the Windows Administrative Tools.
Select Data Sources (ODBC).

Switch to the System DSN tab.

Select MVF.

Click Remove.

At the confirmation message, click Yes.
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Uninstalling the Oracle 9.2 Client software on an
IMPAX Client workstation

(Topic number: 7993)

This step is unnecessary if you are upgrading an IMPAX 6.2 or later Client workstation.

% Note:

If IMPAX Reporting is integrated, the Oracle Client is required. For details on the required
version and installation instructions, refer to the IMPAX RIS InstallShield Technical Guide.

You must perform two procedures to remove the Oracle 9.2 Client. First, you must remove the
System DSN entries for any Oracle ODBC driver in the ODBC Data Source Administrator (refer to
page 74). Second, you must uninstall the Oracle 9.2 Client software.

To uninstall the Oracle 9.2 Client software on an IMPAX Client workstation
1. To open the Universal Installer, click Setup.

2. Select Deinstall Products.
3. In the Inventory dialog, select Oracle Homes > OraHome92 > Oracle9i Client 9.x.
4

. Under Independent Products, select Java Runtime Environment, Oracle Universal Installer,
and Oracle Snap-In Common Files and any files under those headings.

5. Click Remove.

6. At the confirmation message, click Yes.

Oracle 9.2 Client is uninstalled from the workstation.

Installing the IMPAX Client

(Topic number: 7776)

Important!

If installing the Client as part of the upgrade process, .NET Framework 3.5 SP1 must be
installed prior to starting the Client installation.

The following explains how to install IMPAX Client using the default InstallShield package. An
alternative is to automate the installation through a batch file or software distribution tool.
Instructions on installing IMPAX Client that way are provided in Enabling automated installation
of the IMPAX Client software from a command prompt (refer to page 65) and Installing the IMPAX
Installation Server (refer to page 57).
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E Note:

To install the IMPAX Client, you must be logged in as a user in a Administrators role that has
permissions to the Windows Services.

To install the IMPAX Client

1. From the IMPAX Client CD or the IMPAX Client Installation web page
(https://install_server_name/clientinstaller/language_code), start the IMPAX Client installation
program, IMPAXClientSetup.exe.

2. If a File Download dialog appears, click Open or Run.
APreparing to Install message appears.
If on Windows Vista, a cscript.exe prompt may appear. To run it, click OK.
3. If a prompt appears about downloading and installing missing components, click OK.

4. Follow the prompts to download and install Microsoft .NET Framework 3.5, Microsoft NET
Framework 3.5 SP1, or all.

E Note:

After installing a component, the installer may stop running or you may receive an
Installation is not yet conplete message. In either case, rerun the
IMPAXClientSetup.exe program.

Depending on network speed, downloading and installing the Microsoft NET Framework can
take over 30 minutes.

For the .NET Framework 3.5 install, after the download, agree to the installation, accept the
license agreement, and after the installation is complete click OK. If prompted, restart the
computer.

If you do not have a live Internet connection, the downloading will not work. Instead, install
the Microsoft .NET Framework 3.5 from the Client Installer server
(https://install_server_name/clientinstaller/redist/dotnetfx35.exe).

For the .NET Framework 3.5 SP1 install, after the download, if prompted to start the installation,
click OK. If prompted, restart the computer.

5. On the Welcome to the InstallShield Wizard for IMPAX Client screen, click Next.

6. On the License Agreement screen, read the license agreement. If you agree, select I accept the
terms in the license agreement. Click Next.

7. To install the application into C:\Program Files\Agfa\IMPAX Client, on the Destination Folder
screen, click Next.

or

To install the application to another location, click Change. In the Change Current Destination
Folder dialog, browse for the directory location to install into and click OK. On the Destination
Folder screen, click Next.
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8. On the IMPAX Application Server screen, in the Get or confirm application server name field,
type the fully qualified domain name of the Application Server to use. Click Next.

A fully qualified domain name is the full name of a system, including its local host name and
complete domain name. For example, if the Application Server is called radserver, it is on the
network domain called radnet, and radnet is within the healthorg.com domain, the name to
type would be radserver.radnet.healthorg.com.

9. On the IMPAX Login Type screen, select the appropriate authentication method: Windows,
IMPAX, or Smart Card.

+ Windows Authentication—Logs into IMPAX using the Windows session credentials

after launching the IMPAX Client or logging in with a Windows smart card.

+ IMPAX Authentication—Logs into the IMPAX Client separately from Windows. (If
unsure of which option to select, use IMPAX Authentication.)

+ Smart Card Authentication—Logs into the IMPAX Client with a smart card in the
National Health Service (NHS) environment only.
10. Click Next.
11. On the Ready to Install the Program screen, click Install.
The program is installed.

12. On the InstallShield Wizard Completed screen, click Finish.

The IMPAX Client software is installed. You do not have to restart the computer.

Verifying the IMPAX Client upgrade

(Topic number: 15423)
After completing the IMPAX Client upgrade, you should verify that it was successful.

To verify the Client upgrade
1. Open Control Panel.

2. Select Add or Remove Programs.

3. In the Currently installed programs list, verify that Agfa IMPAX Client 6.5.1.xxxx is listed,
where xxxx is the correct build number.

4. Check to ensure that the Client is working as expected, including any wizards.
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Creating standard worklists from the users.xml file

(Topic number: 8021)

During the preparatory phase of migration, the IMPAX 5.2 or 5.3 Select wizards are exported into
the users.xml file created when exporting the IMPAX 5.2 or 5.3 user ID information. Once an IMPAX
Client workstation has been installed and configured, using the users.xml file created from the
exported IMPAX 5.2 or 5.3 Select wizards, create the appropriate IMPAX 6.5.1 standard worklists.

For additional information on standard worklists, refer to "Managing studies using worklists" (topic
number 8430) in the IMPAX 6.5.1 Client Knowledge Base: Extended.

E Note:

When creating a standard worklist in IMPAX 6.5.1, the commands to reset the search criteria,
clear the current worklist, or add search results to the worklist do not have to be specified as
they are all performed automatically.

Controlling permissions for teaching files

(Topic number: 8023)

During migration, the IMPAX 5.2 or 5.3 teaching file folders are migrated to IMPAX 6.5.1, but the
permissions to access these folders are not. To allow users to view the teaching files, the PACS
Administrator must manually configure the access to each teaching file folder.

For additional information, refer to "Controlling permissions for teaching files" (topic number 8586)
in the IMPAX 6.5.1 Client Knowledge Base: Extended.

To control permissions for teaching files
1. In the Text area > Study List, on the Teaching Files tab, right-click on a teaching file folder.

2. Select Configure Access.

3. In the Configure Access dialog, for the required role, select the checkbox in the appropriate
column:

+ Read—allows users in that role to view teaching files in the selected folder.
* Write—allows users in that role to add and modify teaching files to the selected folder.

* Modify Permissions—allows users in that role to use the Configure Access command.
Selecting this checkbox also enables the Read and Write permissions for the role.

Enabling access for a role enables access for all of its sub-roles.
4. Click OK.
5. Repeat steps 1-4 for all teaching file folders.
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Context Server integrations in IMPAX 6.5.1

(Topic number: 8024)

The Context Server is installed when you install the IMPAX Client. After the upgrade, you may find
that some of your integrations no longer work as expected or at all and must be updated. For more
information on using the Context Server and changing your integrations, consult Agfa Professional
Services.
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Initially configuring the
IMPAX Client

The following information explains how to enable Windows authentication if the Client was installed
under IMPAX authentication, how to configure the automatic update service, how to accelerate
Client startup by adding the software to the Startup menu, how to set up a smart card enrollment
station, and how to add users to the smart card enrollment station. More configuration information
is available in the IMPAX 6.5.1 Client Knowledge Base.

Enabling integrated Windows authentication

(Topic number: 10214)

You can configure IMPAX such that users can log into Windows and into IMPAX at the same time.
This single sign-on option saves users the time involved in logging into IMPAX separately.

If you installed the IMPAX Client with the Windows Authentication option, no configuration is
necessary. If you installed it with the IMPAX Authentication option, to use Windows authentication
instead, you must modify the impax-client-main.exe.config file.

E Note:

For configuration purposes, at least one IMPAX Client in the site must be installed with the
IMPAX Authentication option.

To enable integrated Windows authentication
1. Ensure that the IMPAX Client is not running.

2. In Windows Explorer, navigate to the location where the IMPAX Client software is installed;
by default, this is C:\Program Files\Agfa\IMPAX Client.

In this folder are numbered folders (such as 6.5.x.x) that indicate which version of the Client
is being used.
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In the numbered folder of the most recent version of the IMPAX, double-click
impax-client-configure.exe.

From the Authentication list, select the Windows Authentication option.
To save the change, click Save.

To close the dialog, click Close.

Restart the Client.

Two domain options are now available on the Client Login screen: AgfaHealthcare and the
site’s domain.

To ensure that the login information is handled correctly, you may also have to add the
Application Server to the local intranet zone on the Client.

To add the Application Server to the Clients local intranet zone

10.

N e

Launch Internet Explorer.

Select Tools > Internet Options.

In the Internet Options dialog, switch to the Security tab.
Click Local intranet.

Click Sites.

In the Local intranet dialog, click Advanced.

In the Add this Web site to this zone field, type https://<appserver>, where <appserver> is the
fully qualified domain name of the Application Server.

A fully qualified domain name is the full name of a system, including its local hostname and
complete domain name. For example, if the Server is called appserver, on a network domain
called radnet, and if radnet is within the healthorg.com domain, the fully qualified domain
name would be appserver.radnet.healthorg.com.

Click Add. Click OK.
In the Local intranet dialog, click OK, then again in the Internet Options dialog.

For the change to take effect, restart the Client workstation.

Configuring automatic Client updates

(Topic number: 10054)

You can configure the IMPAX Clients to automatically use an updated version of the software when
it becomes available, without having to uninstall and reinstall the software. These updates occur in
the background when the Client is idle; they do not interrupt clinical work.

Automatic updates are installed and configured on the IMPAX Installation Server. Detailed
instructions on installing the Installation Server package are available in Installing the IMPAX
Installation Server (refer to page 57).
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E Note:

For large sites, if the Installation Server is installed on the same machine as the Application
Server, applying a Client update can significantly affect performance of the Application Server.
The Installation Server should either be deployed to a separate 11S-enabled server, or done
during off hours.

Starting the Background Intelligence Transfer service
(Topic number: 10058)

If the Installation Server is armored, as would be the case if an IMPAX Application Server is used as
the Installation Server, the component needed for Client updates to work is disabled. You must start
this service manually.

To start the Background Intelligence Transfer Service
. On the Installation Server, open Control Panel.

1
2. Select Administrative Tools.

3. In the Administrative Tools window, select Services.
4

. In the Services window, right-click the Background Intelligence Transfer Service row and
select Start.

If the Start command is disabled, the service is already started.

5. Close the Services and the Administration Tools windows.

Enabling automatic Client updates
(Topic number: 10065)

The default fully qualified domain name of the Installation Server, both on the Application Server
and the Client (on installation) is the same as the Application Server. Therefore, a newly installed
Client immediately checks to see if the Installation Server is installed on the Application Server, and
if so, updates if required.

To enable automatic Client updates
1. Install the IMPAX Installation Server. Details are provided in Installing the IMPAX Installation
Server (refer to page 57).

2. Note the fully qualified domain name of the Server

A fully qualified domain name is the full name of a system, including its local hostname and
complete domain name. For example, if the server is called updateserver, on a network domain
called radnet, and if radnet is within the healthorg.com domain, the fully qualified domain
name would be updateserver.radnet.healthorg.com.

3. On a Client workstation, log into IMPAX Client as an Administrator user.

4. From the Configure drawer menu [, select Stations
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In the navigation pane, select the station container that this Client station resides in.
In the details pane, expand the General bar.

Switch to the Services Access tab.

® N w

For Service ClientInstaller, in the URL column, type protocol://localhost/ ClientInstaller/,
where protocol is http or https, and localhost is the full server name noted in step 2.

Following the step 2 example, you would type:
http://updateserver.radnet.healthorg.com/ClientInstaller

Note that updates are set for all Client stations organized under the station container you have
configured.

The changes are saved automatically when you switch context (for example, by selecting a
different station container, selecting a different section of the Configure area, closing the
Configure area, or logging out).

9. For the change to take effect, log into and out of each Client installed on workstations in the
configured station container.

10. When a Client gets a new update while the user is working, the user must log out of the Client
and log in again for the new version to take effect.

Disabling automatic Client updates
(Topic number: 10067)

Conversely, you may find it necessary to disable automatic updates at some times or for certain
stations.

To disable automatic Client updates
1. Log into the IMPAX Client as an Administrator user.

2. From the Configure drawer menu [B, select Stations.

3. Inthe navigation pane, select the station container that the Client station to be disabled resides
in.

4. In the details pane, expand the General bar.

5. Switch to the Services Access tab.

6. For Service ClientInstaller, delete the information in the URL column.
The changes are saved automatically when you switch context.

7. For the change to take effect while a user is working, log out of and restart each Client.

Testing an update
(Topic number: 10069)

A common practice is to test a particular update on a few Clients before rolling it out to the entire
site.
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To roll out an update on test Clients first

1.
2.
3.

Log into the IMPAX Client as an Administrator user.
From the Configure drawer menu [§, select Stations.

To create a station container for the test Clients right-click on a container and select Add
Station Container.

For details, refer to "Adding containers and station containers" (topic number 9364) in the
IMPAX 6.5.1 Client Knowledge Base: Extended.

Move the test client stations into that container by dragging them.

For details, refer to "Moving stations and station containers" (topic number 9357) in the IMPAX
6.5.1 Client Knowledge Base: Extended.

. Enable automatic updates for the test Clients, as described in Enabling automatic Client updates

(refer to page 82).

Disable automatic updates for the remaining Clients, as described in Disabling automatic Client
updates (refer to page 83).

On the Installation Server providing the Client updates, install the updated version of the
Client.

. To get the updates onto the test Clients, log out of and restart each workstation in the configured

station container.

If the update works well, enable the update on the remaining Clients, as described in Enabling
automatic Client updates (refer to page 82).

Reconfiguring the Manifest file with the correct Server name
(Topic number: 10071)

If the Installation Server name does not match the security ticket name, the update causes an error
message in the log file as follows:

The BITS service error message for this job is The requested URL does not exist on the
server. Some misfile may be causing BITS to have trouble with a source or destination path.

To correct this problem, you can reconfigure the Manifest file with the correct Server name.

To reconfigure the Manifest file with the correct Server name

1.

At a command prompt, type:
CreateManifest.exe -f <RootInstallFolder> -v <IMPAXversion> -m <MachineName>
Where:

* <RootInstallFolder> is the path to the IMPAX Installation Server package directory. This
argument defaults to the folder that CreateManifest was run from.

+ <IMPAXversion> is the version number of the update.

* <MachineName> is the fully qualified domain name of the local machine. This argument
defaults to the name in the network's DNS.
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Additional parameters for the CreateManifest command include:

Parameter Description

PostProcessor The assembly to use to complete post-install configuration. This
argument defaults to Agfa.Client.Updater.PostProcessor.dll.

URLProtocol The URL protocol the client will use to retrieve the updated files
contained in the manifest. This argument defaults to http.

VirtualDirectory The name of the virtual directory for the Installation Server. This
argument defaults to ClientInstaller.

Backing out of a particular Client update
(Topic number: 10073)

If the update causes problems, whether on test Clients or all Clients, you can back out of it without
doing an uninstall on individual Client workstations.

To back out of a particular Client update
1. Ensure the Background Intelligent Transfer and PACS Client Updater services are running.

2. On the Installation Server, uninstall the update.
3. Reinstall the old version on the Installation Server.

When the Clients configured to detect automatic updates start, they detect that the version has
changed. They also detect that the version number (which is older) is already available. Instead
of updating, the Clients simply switch back to running the previous version. They continue to
do so until a new update is available.

Adding IMPAX Client to the Startup menu

(Topic number: 7747)

On startup, the IMPAX Client performs some initial configuration tasks. If the user logs in before
these tasks are completed, a delay occurs before the IMPAX Client window opens. To reduce this
delay, add the IMPAX Client to the Windows Startup menu. This task is not required; it is an option
for improving performance.

To add IMPAX Client to the Startup menu
Select Start > All Programs.

Go to Agfa IMPAX > IMPAX Client.
Right-click and drag IMPAX Client to the Startup menu.
Select Copy Here.

A

Confirm that you want to make this change for all users.
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Configuring IMPAX to burn CJK studies to CD

(Topic number: 49325)
Complete the following steps to enable CJK support when exporting a study to CD.

To configure IMPAX to burn CJK studies to CD
1. On the IMPAX Server where the MVF CD Export server component is installed
a. Ensure that Perform translation for character data in the ODBC connection to the

database is cleared, as specified in "Configuring the connection to the SQL Database
Server" in the IMPAX 6.5.1 AS300 Installation and Configuration Guide.

b. To enable CJK language support on Windows XP, install the East Asian language files
(refer to page 47) and select the region for the IMPAX Client (refer to page 49) as needed.

2. On the IMPAX Application Server, complete "Viewing East Asian characters in the IMPAX
Client" in the IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide.

3. On each IMPAX Client workstation:

a. Specify which East Asian characters are used for patient names. Refer to "Defining which
East Asian characters are used for patient names in the Image area" (topic number 8724)
in the IMPAX 6.5.1 Client Knowledge Base: Extended.

b. For IMPAX Client workstations running Windows XP or Windows 2003, complete all
tasks in Configuring languages on Windows XP (refer to page 47).

For IMPAX Client workstations running Windows Vista, complete all tasks in Configuring
languages on Windows Vista (refer to page 50).

Important!

Any computer used to view the study on CD must have the language installed or the characters
will not display properly.

Changing the default language of the Client
Installer page

(Topic number: 56657)

By default, the Client Installer page is displayed in English. You can change the URL of the page to
point at Client Installer page in the language appropriate for your site.

To change the default language of the Client Installer page
1. Log onto the Installation Server.
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. Navigate to the clientinstaller folder.

The default location is C:\inetpub\wwwroot\clientinstaller. The clientinstaller folder contains
a list of folders for different languages, with either two letters (for example, en) or four letters
(for example, zh-cn). Each language folder has the Client Installer page translated into the
appropriate language.

. In Notepad, open the index.html file.

Search for URL=en.

. Change the en to match the folder name of the language you want.

For example, to display the Client Installer page in French, change the URL to URL=fr. To
display the Client Installer in Simplified Chinese, change the URL to URL=zh-cn.

Setting up the smart card enrollment station

(Topic number: 67021)

To enable smart cards, one IMPAX Client workstation with a smart card reader installed must be
set up as an enrollment station. Smart card users are then added to the enrollment station and must
be mapped to the IMPAX roles and users.

To set up the smart card enrollment station

1.
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On the workstation to be used as the smart card enrollment station, log in as the enrollment
user.

Open Internet Explorer.

Select Tools > Internet Options.

Switch to the Security tab.

From the list of zones, select Internet.

Click Custom level.

Under Download unsigned ActiveX controls, select Prompt.

Under Initialize and script ActiveX controls not marked as safe, select Prompt.

To save the changes, click OK.

. In the Warning! dialog, click Yes.

. In the Select a Web content zone to specify its security settings field, select Local Intranet.
. Repeat steps 5 to 9.

. To close the Internet Options dialog, click OK.

. Navigate to http://your_domain/certsrv/.

. Select Retrieve the CA certificate or certificate revocation list.Click Next.

. Click Install this CA certificate path.

. In the Potential Scripting Violation dialog, click Yes.
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18.
19.
20.
21.
22.
23.
24,
25.
26.
27.
28.
29.
30.
31.

The workstation is set up as an enrollment station. You can now add users (refer to page 88).

Adding smart card users to the enrollment station

To return to the home page, click Home.
Select Request a certificate. Click Next.
Select Advanced request. Click Next.

Select Submit a certificate request to this CA using a form. Click Next.

From the Certificate Template list, select Enrolment Agent.

From the CSP list, select Microsoft Base Cryptographic Provider v1.0.
Beside Key Usage, select Both.

Select Create new key set.

Select Mark keys as exportable.

From the Hash Algorithm list, select HSA-1.

Click Submit.

Click Yes.

To install the certificate, click Install the certificate.

In the Potential Scripting Violation dialog, click Yes.

(Topic number: 67024)

The following conditions must be met before this procedure can be completed.

+ The enrollment station must be set up (refer to page 87)

+ A smart card reader with appropriate drivers must be installed on the enrollment station

* You must be able to log into the enrollment station directly . A remote desktop connection

cannot be used.

To enable smart cards, add each smart card user to the enrollment station.

To add a smart card user to the enrollment station

1.

Log into the enrollment station as the enrollment user.

2. Open Internet Explorer.

3. Navigate to http://your_domain/certsrv/.
4.
5
6

Select Request a certificate. Click Next.

. Select Advanced request. Click Next.

Enrollment Station. Click Next.
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7. At the ActiveX prompt, click Yes.
8. From the Certificate Template list, select Smartcard User.
9. Under User To Enrol, click Select User.
10. In the Enter the object name to select field, type the name of the user to add.
11. Click Check Names.
12. Click OK.
13. In the Select Certificate dialog, select the enrol certificate. Click OK.
14. Remove the enrollment user smart card from the card reader.
15. Insert a blank smart card.

16. Click Enrol.

The user is added to the enrollment station. Repeat this procedure for each smart card user.

Mapping smart card users to IMPAX roles and users

(Topic number: 114058)
Smart card users must be mapped to the IMPAX roles and users before using the IMPAX Client.

To map smart card users to IMPAX roles and users

1. Refer to the section "Mapping existing groups or users into IMPAX roles and users" (topic
number 9436) in the IMPAX 6.5.1 Client Knowledge Base: Extended.

2. From this section, select and implement the procedure that is correct for your site.

Disabling hyperthreading on the Client

(Topic number: 67680)

When hyperthreading is enabled, many IMPAX performance and stability issues occur. To help
prevent these issues, disable hyperthreading on the IMPAX Clients.

To disable hyperthreading on the Client
1. To access the BIOS, restart the IMPAX Client.

When the setup prompt appears, press F10.
In the Language Select window, select English.
Select Advanced > Multi-core.

To disable hyperthreading, select Disabled.

AN

To accept the change, press F10.
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7. To save the change and exit the BIOS, select Save and exit.

Completing other IMPAX Client configuration tasks

(Topic number: 7730)

When first implementing IMPAX at a site, the PACS Administrator must complete many other
Client configuration tasks. These include:

+ Configuring the workstation settings, including monitors

* Defining roles and users, including permissions and operations

Operation defaults can differ between an install and upgrade of the Client. Check the settings
for the operations to ensure the appropriate access to features is given.

* Creating and adding worklists

+ Defining relevance rules for opening priors

+ Setting hanging protocols for viewing studies (for radiologists)

+ Configuring modality and body part preferences, including Image area tools
* Configuring DICOM printers and printing

* Readying image wizards and enabling preconfigured ones

* Defining the dictation workflow (for radiologists)

+ Setting up logging of system activity

Information on how to complete these tasks is provided in the IMPAX 6.5.1 Client Knowledge Base:
Extended, “Administering IMPAX” section (topic number 11588).

When configuring a newly installed Client station container for a new user at a site where IMPAX
is already implemented, special configuration may or may not be required. In some cases, you only
have to assign the new user to a role that has already been configured. In other cases, you have to
define new preferences and worklists for the new user.

If installing another instance of the Client software for an existing IMPAX user, you may not have
to perform any configuration tasks other than those detailed here, and some station configuration.
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Installing related
software

You can install software packages that are integrated with the IMPAX Client software. Which of
these you need to install depends on who will be using the workstation, where the workstation is
located (within or outside the network firewall), and what licenses are available at your site.

Installing the Agfa Orthopaedic Tools software

(Topic number: 7771)

The Agfa Orthopaedic Tools software is used for applying digital templates and completing
measurements in preparation for orthopaedic surgery. The IMPAX Orthogon and OrthoView
applications are also available. This software is available on a separate installation CD and requires
a hardware dongle.

To install the Agfa Orthopaedic Tools software

1. Refer to the Agfa Orthopaedic Tools installation documentation for current and complete
instructions.

Installing IMPAX Clinical Application software

(Topic number: 113248)

IMPAX can be integrated with a variety of clinical applications
+ IMPAX Volume Viewing basic (MIP, MPR) and IMPAX Volume Viewing extended (3D)
+ IMPAX Virtual Colonoscopy

+ IMPAX PET-CT Viewing
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+ Qasis for IMPAX

This software is available on a separate installation CDs.

To install IMPAX Clinical Application software

1. Refer to the appropriate IMPAX Clinical Application installation documentation for current
and complete instructions.

Installing the IMPAX RIS Client software

(Topic number: 7777)

If the IMPAX Reporting is to be used as the reporting solution through either speech recognition
or transcription, IMPAX RIS Client software must be installed on the workstation. Before installing
the IMPAX RIS Client on the IMPAX Client workstation, ensure you follow these recommendations.

IMPAX 6.5.1 supports integration with IMPAX RIS 5.7.

Recommendations and tips

+ If the workstation’s operating system is Windows Vista 64-bit, do not install IMPAX RIS in
the Program Files (x86) folder. We recommend creating a new folder (for example, C:\Agfa)
and installing the IMPAX RIS Client suite here.

+ To ensure the workstation is configured correctly, refer to IMPAX RIS Client hardware
specifications in the IMPAX RIS documentation.

IMPAX RIS Client modules required for IMPAX Reporting

When IMPAX Reporting is required, you must run other IMPAX RIS modules on the IMPAX Client
workstation. During the installation, select:

+ Centura
+ Speech Integration Text area

+ MS Word templates (sub feature of QDoc)

To install the IMPAX RIS Client software
1. Refer to the IMPAX RIS InstallShield Technical Manual for current and complete instructions.

2. For the speech integration to work, the IMPAX RIS must also be configured appropriately.
Consult Agfa Professional Services for assistance.
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Installing the TalkStation Client software

(Topic number: 7769)

TalkStation is a flexible dictation interface allowing for real-time or batch-mode dictation. Before
installing, be aware that:

« TalkStation Client does not work outside the network cluster, on remote clients.

+ All TalkStation Server components must be installed first. Refer to the TalkStation 4.0 Server
Installation Guide.

+ If the TalkStation Client is already installed on the workstation, you do not have to reinstall
it.

To install TalkStation Client software
1. Refer to the TalkStation 4.0 Client Installation Guide for current and complete instructions.

E Note:

If intending to use TalkStation with the IMPAX RIS, special installation and configuration of
the IMPAX RIS software is required. For more information, refer to the IMPAX RIS
documentation and consult Agfa Professional Services.

To install the TalkStation 4.0 User Knowledge Base
1. Refer to the TalkStation 4.0 Client Installation Guide for current and complete instructions.

Installing license servers

(Topic number: 7810)

IMPAX Client can be integrated with the Orthopaedic application (Agfa Orthopaedic Tools), the
Agfa Clinical applications, and third-party applications. Refer to the installation documentation for
the appropriate product to install the license server.

E Note:

We do not recommend using the Application Server as the license server.
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Integrating the IMPAX
Enterprise Solution

The IMPAX Enterprise Solution offers a fully integrated RIS, PACS, and Reporting solution.

What is the IMPAX Enterprise Solution?

(Topic number: 56712)

The IMPAX Enterprise Solution is an integrated offering designed to meet the needs of large healthcare
organizations. The IMPAX Enterprise Solution:

* Leverages the diversity and depth of the Agfa IMPAX product portfolio

+ Forms an integrated solution for large-scale healthcare institutions with multi-disciplinary and
multi-departmental needs

* Delivers consistent and predictable workflow and outcomes, employing workflow-aware
adaptability and scalability

Key modules in the IMPAX Enterprise Solution
The foundations of the IMPAX Enterprise Solution are the key modules in a fully integrated offering:
+ PACS

* RIS

* Reporting
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Integrating into the IMPAX Enterprise Solution

(Topic number: 56715)

As part of the IMPAX Enterprise Solution, this product must be configured to fully support an
integrated RIS-PACS-Reporting solution. For details about planning and implementing a
RIS-PACS-Reporting integration, contact your local Agfa representative.
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Installing device drivers
on the computer

Device drivers are files that provide the computer with the configurations and specifications of
certain hardware devices. Without the driver file, the computer cannot communicate with the device.

Installing device drivers

(Topic number: 97907)

Device drivers are files that provide the computer with the configurations and specifications of
certain hardware devices. Without the driver file, the computer is unable to communicate with the
device. Configure the appropriate drivers on the IMPAX Client.

To install device drivers
1. For each network adapter installed on the server, install the network adapter driver. Do not
install the SNMP option.

2. Install the Chipset Software Installation Utility.

3. Install the video drivers.

Installing Windows device drivers

(Topic number: 7766)

On Dell workstations, the Windows drivers are located on the Dell Resource CD. This topic provides
instructions on how to install the drivers on this type of workstation. When installing on another
type of workstation, the method will be similar, but refer to the manufacturer documentation for

details.
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Tip:

After installing a device driver, you do not have to restart the computer when prompted. You
can wait until all drivers have been installed, then restart it only once.

Installing the Dell Resource CD

(Topic number: 50968)

On Dell workstations, the Windows drivers are located on the Dell Resource CD. Install the Resource
CD before installing any device drivers.

To install the Dell Resource CD
1. Insert the Dell Resource CD.

2. When prompted to install it, click OK.
3. To start the installation program, click Next.
4. When the installation is finished, click Finish.

Installing the controller driver
(Topic number: 50971)

Install the drivers that control the transfer of data from a computer to a peripheral device.

ﬂ CAUTION!

You must install this device driver before any others.

To install the controller driver
1. On the Resource CD screen, click Next.

Under Controller Drivers, double-click Intel Chipset Software Installation.
Scroll down the page and click Extract.

To start the extraction, click Continue.

To unzip the files to the default directory, click OK.

When asked if you want to create the directory, click Yes.

To confirm that the files were extracted successfully, click OK.

To start the installation, click Next.

© ® N AN e w D

To accept the license agreement, click Yes.

—
o

. On the Readme screen, click Next.

—
—

. If you prefer to restart the computer after each driver is installed, click Yes and wait for the
computer to restart. Otherwise, click No.
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Installing device drivers
(Topic number: 50977)

Complete the installation for all device drivers listed on the Resource CD.

To install device drivers

1. From the list of drivers in the Resource CD screen, for each type of driver that has a checkmark
beside its name and has not already been installed:

Double-click the driver name.

IS

Scroll down the page and click Extract.

To start the extraction, click Continue.

/oo

To unzip the files to the default directory, click OK.
To create the directory, click Yes.
To confirm that the files were extracted successfully, click OK.

To start the installation, click Next.

ISEECCI S

If you prefer to restart the computer after each driver is installed, click Yes and wait for
the computer to restart. Otherwise, click No.

2. After all drivers are installed, restart the computer.

After the computer restarts, log into Windows as an administrator-level user.

Verifying that all device drivers were correctly
installed

(Topic number: 50980)

Once all device drivers have been installed, verify that the installation was completed successfully.

To verify that all device drivers were correctly installed
. From the Start menu, right-click Computer and select Properties.

. Switch to the Hardware tab.

1
2
3. Click Device Manager.
4. Check all listed drivers.
5

. If any errors are indicated, reinstall that type of driver.
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Troubleshooting IMPAX
Client

As you install the IMPAX Client, you may encounter various installation problems.

Troubleshooting: Path not found after workstation
restart

(Topic number: 7761)

Issue

After installing the NET Framework, the computer has to be restarted. The IMPAX Client installation
program is then supposed to resume automatically. Instead, an error message appears: Cannot fi nd
the path specified. The IMPAX Client installation program has to be restarted manually.

Details

This problem occurs only when installing the Client from a network drive that is not permanently
mapped.

Solution

If installing from a network drive, first map the network drive to a drive letter and select the Reconnect
atlogon checkbox.
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Troubleshooting: IMPAX Client cannot contact the
Application Server

(Topic number: 7792)

Issue
When trying to start the IMPAX Client, an error message appears:

Cannot contact Application Server. Please contact your system
admi ni strator.

Details

This message appears when the certificate is not installed or has expired.

Solution

Install or renew the certificate on the Application Server. Refer to the IMPAX 6.5.1 Application Server
Installation, Upgrade, and Configuration Guide.

Troubleshooting: IMPAX Client slow and erratic
post-upgrade

(Topic number: 10210)

Issue
After upgrading, IMPAX Client display is very slow at a site using McAfee Antivirus software.

Details
A McAfee Antivirus setting called Buffer Overflow Protection (BOP) can cause this behavior.

Solution

Disable BOP in McAfee. Alternatively, use McAfee EPO or Protection Pilot to reconfigure the BOP
to run only at fixed intervals, such as every five minutes.
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Troubleshooting: Failure to get data from the
Application Server

(Topic number: 7797)

Issue
IMPAX Client login succeeds, but then an error message appears:

A request for data fromthe Application Server has
failed.

Details

The problem is related to the security certificate validation.

Solution
1. In Internet Explorer, select Tools > Internet Options.

2. Switch to the Advanced tab.

3. Under Security, ensure that the Check for server certification revocation (requires restart)
checkbox is cleared.

This checkbox is selected by default on Windows 2003 but cleared by default on Windows XP.
4. Click OK.

5. If you had to clear the checkbox, restart the computer.

Troubleshooting: When launching the IMPAX Client,
an application error occurs

(Topic number: 120052)

Issue
When launching the IMPAX Client, I received the following error:

The application failed to initialize properly (0xc0000135). Cick on K to
term nate the application.

Details
The IMPAX 6.5.1 Client requires .NET 3.5 SP1 be installed.

Solution
1. Uninstall the IMPAX Client (refer to page 104).
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2. Install NET 3.5 SP1 (refer to page 71).
3. Re-install the IMPAX Client (refer to page 75).

Troubleshooting: Agfa Ortho Tools does not launch
due to network dongle error

(Topic number: 7762)

Issue
The Agfa Ortho Tools does not launch, giving an Error 7 Hardl ock not found message.

Details

Communication problems can arise when using a network dongle for the Agfa Ortho Tools.

Solution
To troubleshoot this problem:
+ If the dongle network Server is running on Windows XP SP3 or Windows 2003 SP1, ensure
that the connection is not being blocked by the Windows firewall.

* Ensure that the correct <dongle_id>.alf appears on the Server. If in doubt, delete the existing
file and create a new one.

* Ensure that the network dongle is inserted in the servers USB port.
+ Ensure that the Client can ping the Server.

+ To ensure that the Client is using the correct IP address, on the client workstation, open Control
Panel and select System. Switch to the Advanced tab. Click Environment Variables. Ensure
that the value for HL_SEARCH is IP and the value for HLS_IPADDR is the dongle server’s IP
address. If the values are missing completely, add them.

* On the Client, ensure that the C:\Program Files\mediCAD II\CONFIG\global.ini file is neither
missing nor damaged.
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Uninstalling IMPAX
software

The following information explains how to uninstall the IMPAX Installation Server package and
the IMPAX Client software, if needed.

Uninstalling the IMPAX Installation Server package

(Topic number: 7751)

If you need to reinstall the IMPAX Installation Server package, you must first uninstall the previous
version first through Control Panel. Otherwise, the reinstallation fails.

To uninstall the IMPAX Installation Server package

1.

A

On the IMPAX Installation Server machine, open Control Panel.

Select Add/Remove Programs.

Under Currently installed programs, select AGFA IMPAX Installation Server <build number>.
Click Remove.

When asked to confirm the removal, click Yes.

A Preparing to remove dialog opens, then the IMPAX Installation Server package is uninstalled.
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Manually uninstalling the IMPAX 6.2 or later Client
software (optional)

(Topic number: 7752)

Important!

This procedure is optional. You should not have to uninstall the IMPAX 6.2 or later Client
software prior to installing the IMPAX 6.5.1 Client software. However, if the IMPAX Client is
installed on Windows Vista, we recommend uninstalling it prior to the installation of the new
version.

The following procedure removes the IMPAX Client software but not any integrated software (such
as the Orthopaedic Application, TalkStation, or Volume Viewing).

To manually uninstall the IMPAX 6.2 or later Client software
If running, log out of the IMPAX Client and close the Login window.

Open Control Panel.
Select Add or Remove Programs.
Under Currently installed programs, select AGFA IMPAX Client build_number.

Click Remove.

AN U o A e

When asked to confirm the removal, click Yes.

A Preparing to remove dialog opens, then the IMPAX Client software is uninstalled.

Uninstalling the IMPAX 6.5.1 documentation

(Topic number: 118482)

If required, you can uninstall the IMPAX 6.5.1 documentation.

To uninstall the IMPAX 6.5.1 documentation
1. Open Control Panel.

2. In Windows 2003, select Add or Remove Programs. In Windows 2008, select Programs and
Features.

3. In the Add or Remove Programs dialog, under Currently installed programs, select AGFA
IMPAX version Knowledge Base buildnumber Documentation.

4. Click Remove.
5. In the confirmation dialog, click OK.
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A progress dialog appears as the documentation is uninstalled, giving the amount of time
remaining. When the process is complete, the dialog closes.

6. Close the Add or Remove Programs dialog.

All installed IMPAX 6.5.1 documentation is uninstalled.
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Migration references

The IMPAX 6.5.1 Migrations Reference Guide provides reference material to support migrations
from IMPAX 5.2 to IMPAX 6.5.1. The information includes:

* Obsolete IMPAX 5.2 privileges
+ New operations for IMPAX 6.5.1
* Privileges from IMPAX 5.2 that are common to IMPAX 6.5.1

+ Default operations for each role
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External
software licenses

Some of the software provided utilizes or includes software components licensed by third parties,
who require disclosure of the following information about their copyright interests and/or licensing
terms.

AutoFac 2.1.13

(Topic number: 121742)

Autofac IoC Container

Copyright (c) 2007-2008 Autofac Contributors
http://code.google.com/p/autofac/wiki/Contributing

Other software included in this distribution is owned and licensed separately, see the included license
files for details.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject
to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
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ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

Editline 1.2-cstr

(Topic number: 121768)

Copyright 1992 Simmule Turner and Rich Salz. All rights reserved. This software is not subject to
any license of the American Telephone and Telegraph Company or of the Regents of the University
of California. Permission is granted to anyone to use this software for any purpose on any computer
system, and to alter it and redistribute it freely, subject to the following restrictions: 1. The authors
are not responsible for the consequences of use of this software, no matter how awful, even if they
arise from flaws in it. 2. The origin of this software must not be misrepresented, either by explicit
claim or by omission. Since few users ever read sources, credits must appear in the documentation.
3. Altered versions must be plainly marked as such, and must not be misrepresented as being the
original software. Since few users ever read sources, credits must appear in the documentation. 4.
This notice may not be removed or altered.

Flexgrid for .NET

(Topic number: 7695)

Portions Copyright © ComponentOne, LLC 1991-2002. All Rights Reserved.

ICU License - ICU 1.8.1 and later

(Topic number: 13533)

COPYRIGHT AND PERMISSION NOTICE
Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the Software and that
both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FORANY CLAIM, ORANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
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PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising
or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective
owners.

Log4Net

(Topic number: 7648)

This product includes software developed by The Apache Software Foundation
(http://www.apache.org/). Please read the LICENSE files present in the Help > About dialog of the
IMPAX Client.

OpenSSL

(Topic number: 121771)

This is a copy of the current LICENSE file inside the CVS repository.
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and
the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both
licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please
contact openssl-core@openssl.org.

OpenSSL License
/>(-

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
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3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use
in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear
in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS" AND ANY EXPRESSED
ORIMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

*

*

* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

*

*/

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

* This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscapes SSL.

*

*This library is free for commercial and non-commercial use as long as the following conditions are
aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
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lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution
is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
of the parts of the library used. This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

*

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement: "This product includes software
written by Tim Hudson (tjh@cryptsoft.com)"

*

*THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

* The licence and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

*/
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TCL 8.5.3

(Topic number: 121781)

This product includes software developed by The TCL Developer Xchange, and is subject to the
following license:

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc.,
Scriptics Corporation, and other parties. The following terms apply to all files associated with the
software unless explicitly disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and
its documentation for any purpose, provided that existing copyright notices are retained in all copies
and that this notice is included verbatim in any distributions. No written agreement, license, or
royalty fee is required for any of the authorized uses. Modifications to this software may be
copyrighted by their authors and need not follow the licensing terms described here, provided that
the new terms are clearly indicated on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OF THIS SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES
THEREOEF, EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. THIS SOFTWARE IS
PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND DISTRIBUTORS HAVE NO
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR
MODIFICATIONS.

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. government, the
Government shall have only "Restricted Rights" in the software and related documentation as defined
in the Federal Acquisition Regulations (FARs) in Clause 52.227.19 (c) (2). If you are acquiring the
software on behalf of the Department of Defense, the software shall be classified as "Commercial
Computer Software" and the Government shall have only "Restricted Rights" as defined in Clause
252.227-7013 (c) (1) of DFARs. Notwithstanding the foregoing, the authors grant the U.S.
Government and others acting in its behalf permission to use and distribute the software in accordance
with the terms specified in this license.

Xerces C++ Parser, version 1.2

(Topic number: 121761)

This product includes software developed by The Apache Software Foundation
(http://www.apache.org/). Please read the LICENSE files present in the Help > About dialog of the
IMPAX Client.
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Zlib

(Topic number: 7595)

zlib.h -- interface of the 'zlib' general purpose compression library Version 1.2.1, November 17th,
2003

Copyright (C) 1995-2003 Jean-loup Gailly and Mark Adler

This software is provided “as-is”, without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.
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Glossary

A
ADT

Admission, Discharge, Transfer. An ADT
message contains patient demographic and
visit information that is stored by a HIS or
RIS.

Application Server

Intermediary server between IMPAX Client
and IMPAX Server machines. LDAP,
Documentation, and other Business Services
reside on the Application Server.

Archive Server

The IMPAX server that manages the archive.
The Archive Server handles requests to store
studies to the archive and to retrieve studies
from the archive. The Archive Server stores
studies in its cache before archiving them to
long-term storage.

C

cluster

A networking solution combining two or more
otherwise independent computers, enabling
them to work together in managing hospital
data.

Connectivity Manager

A middleware component in the integration
between hospital information systems and
other hospital imaging departments.
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Connectivity Manager also provides
connectivity to each modality and the PACS.

D

database

A collection of data that is organized so that
its contents can easily be accessed, managed,
and updated.

device driver

A software program that controls data transfer
between a computer and a peripheral device,
such as a printer, CD-ROM, or cartridge
driver. It may control internal system features,
such as digital video or audio playback.

DICOM

Digital Imaging and Communications in
Medicine. The standard communication
protocol used by a PACS, HIS, or modality to
exchange information or images with other
systems.

F
firewall

On alocal area network (LAN) connected to
a larger network, the security system that
prevents outside intrusion and that keeps
internal information from getting out.
Typically, all traffic must pass through the
machine on which the firewall is implemented.
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H

hardware dongle

A device that attaches to a computer to control
access to a particular application. Dongles
provide the most effective means of copy
protection. Typically, the dongle attaches to a
PC’s USB port.

HIS

Hospital Information System. The database
used by a hospital to manage patient
information and scheduling.

HIS verification

An option that forces the PACS to verify all
incoming images from an acquisition station
or modality against specific criteria, such as
the patient ID and accession number. The
PACS sends a message through the RIS
Gateway to verify the criteria against what is
contained in the HIS. If the criteria match,
then the images can be stored permanently.

HL7

Stands for Health Level 7, a standard
communication protocol used for the
transmission of medical information. HL7 is
used primarily by HIS systems and does not
support transmission of images.

HTTPS

Hypertext transfer protocol, secure, a URL
access method for connecting to http servers
using SSL (secure sockets layer).

Image area

Component of the IMPAX Client application
that displays study images. The Image area
includes many tools for viewing and marking
up images.
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IP address

The Internet Protocol address is a numeric
address that identifies the station to other
TCP/IP devices on the network.

L

load balancing

Distributing processing and communications
activity evenly across a computer network so
that no single device is overwhelmed.

M

Macro enterprise

A Macro enterprise is an environment
comprised of multiple clusters or Micro
enterprises and coordinated by a central Data
Center. It is the most common deployment

type.

master Curator

When using multiple Curators, the
first Curator that runs, which owns the job
queue.

modality

An imaging discipline, such as CT, or a device
that gathers digital information, such as
digitizers for X-ray film, MRI scanners, and
CR devices.

N

network

A group of computers, peripherals, or other
equipment connected to one another for the
purpose of passing information and sharing
resources. Networks can be local or remote.

Network Gateway

The Network Gateway is part of the IMPAX
MVFE cluster. Essentially, this is the workflow
manager of the IMPAX 6.0 and later system.
The Network Gateway controls the studies
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coming into the cluster from an acquisition
station, validates these incoming studies
against information from the HIS or RIS, and
routes the validated studies to cache or archive.

0
operations, IMPAX

The IMPAX actions allowed by a permission.
For example, operations include dictation,
printing to paper, and executing SQL
statements through CLUI. You can further
refine some operations by setting a study status
flag on the operation. For example, you can
allow printing only on dictated studies.

P
PACS

A Picture Archive and Communication
Systems (PACS) makes it possible to
electronically store, manage, distribute, and
view images.

permissions, IMPAX

Permissions define the available IMPAX
features and types of studies that users in a
particular role have access to. Permissions are
made up of a set of operations.

R
RIS

Radiology Information System. Responsible
for scheduling exams and for report
management in the Radiology department.

S

single-host configuration

A configuration in which the Database,
Archive Server, and Network Gateway server
components are all installed on a single server.

single-server configuration

An IMPAX single server is a Windows server
that runs the AS300 Server software in a
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single-host configuration along with the
Application Server and Connectivity Manager
software.

slave Curator

When using multiple Curators, the secondary
Curators. Though the master Curator owns
the job queue, PREPARE jobs are associated
with the Curator that started the job.

SSL

Secure Sockets Layer. A protocol from
Netscape Communications Corporation,
which is designed to provide secure
communications on the Internet.

SSL certificate

A digital certificate with the SSL protocol that
has been issued by a certificate authority.

standalone station

Windows server on which the IMPAX Client,
AS300, and Application Server software are
installed. Runs under Windows XP SP3. The
standalone does not have its own installation
program. To create a standalone , the AS300,
Application Server, and Client installation
programs are each run separately.

station containers

In the navigation pane of the Configure area
- Stations section, the station containers are
like folders that organize groups of stations.
You can set configuration options for the
station containers, and all stations within that
container inherit those configuration options.

T

TalkStation

TalkStation is voice recognition software that
can be integrated with IMPAX. TalkStation
can convert spoken speech to typed text
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without having to go through a transcription
phase.

Text area

Component of the IMPAX Client that displays
study, order, and report information.

U

user

Users represent individuals, such as a
radiologist or a clinician. Each user must
belong to at least one primary role. A user can
also belong to other secondary roles. Users
inherit permissions, licenses, and preferences
from their role.

W

web cache

Images that have been compressed by Curator
are stored in the web cache. These images are
compressed using Mitra Wavelet compression
to reduce their size for access over low
bandwidth.

workflow

A sequence of events, initiated by a trigger
event.

worklist

A collection of patients and their studies. For
radiologists, the worklist is analogous to a pile
of film jackets. They use the worklist to know
which studies they must interpret during a
specific time period. For technologists, a
worklist is a list of the studies they must
perform at specific times for each patient.
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Index

NET

installing Framework........... 61,63,71,75

System Iequirements.........coceeveeervenernene 15
NET 3.5 SPluuuueiicieeeeeeeeeeeee e 101
A
accessing

teaching files........ccceevreveninennencninenns 78
accessing Client Installer page..................... 62
active content enabling........c.cccccceueuenee. 45, 46
adding

Clients to Start menuU.......oceevvervverveenneen 85

languages.......coceeveeenineenenueennnnes 48,51, 53
Administration Tools

languages.......cccoeveeveenurnencne 46, 47, 50, 53
Adobe Reader......coueeeeeeeeeeeeeeeeeeeeeeeenae 15, 28
Agta Orthopaedic Tools

INStalling...ccoveveeveenirenireirecneeeeene 91
ANtIVIrUS SOftWATE..cvvvveeevecrecrecrecrecee e 29

troubleshooting.......c..cccoeveveeencneennee. 100
application error........coeeeceeeverevereeeneenenes 101
Application Servers

communication problems.................. 101

entering name Of.......c.coceceeeruerenuencne 63,75

in IMPAX cluster.....cocvevevveevvecneceennnennes 9

installing IMPAX Installation Server

16 ) o DS UURPRRRURRON 57

order of installation........cccccevvervvervvennenn 12
Archive Server.....oiiiviviirieeireereereeeneens 9
Asian languages

CD burning........ceeeeveeevereneneeencsenenenn. 86

installing files.......ccceceveenunnencne. 47,50, 53
authentication.....cceeeeeeeeeeveeereeneennn. 63, 67, 75
authorities, SSL certificate ......cccevevvevevrennene. 59
Autofac software license..........cocvevuvvvveennnne 107
automated installation..........ceceevevuvevrinnnnne 65
automatic updates.........cccevereeueuenenne. 56, 57, 61
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enabling Windows..........ccccccuu. 39, 42, 44
B
backing out of an update.........cccccerevenirunc. 85
Barco monitorsS......eeeeeeeeeeeeeeeeeerreveeeeenns 14, 27
BITS SEIVICE..ccitiiieeieeeeeeeeeeeeieeeeeeeeseeans 82, 84
browser

CONfigUIING.....ccevvvuerireeerieenieeceane 45, 46

TEQUITEMENTS. .cveveeenerreneeeeenreneereeennens 15

security certificates........ccoevereeercruenenenn 58

UPErading....cccveeueeeeveverreneneeeneeeseeieeeee 28
browsers

certificate authorities.....c..ccceeereruenennee. 59
Bulgarian interface........coceceveevcrencnincncnnene. 46
C
CD burning

CJK sUppOTIt..ccccncriieiieniieiicrenenenns 86
CD eXPOTrting....ccceceevereereeerereeneesenenrereenennens 12

CJK SUppOrt..ccccncreiiinieniieiicenenenns 86
CD for Client installation, creating............. 62
certificates

See SSL certificates
changing

languages.......cccceevererueuerecrnnunen 49, 52, 54

taskbar settings.......cocoeeeerererucreenenennns 45

Windows colors.....eeeeeeeeeeeeennee.. 38, 41, 44
Chinese interface......ccccevueeeen..... 46, 47, 50, 53
CJK support

See East Asian language files
Client

fails to launch......cceceeecnenncnenenenns 101
Client Installer page

ACCESSING.uvrurrereeeernerieneeeeeerenreeeeenenne 62

default language......ccceoeeerevrnencrnecnnne 86
Clients
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creating installation CD.........ceeuueeee. 62

installation Of.....cccoveeeeeeeeeeennen.. 56, 63, 75
Installation Server..........cceccvevencruenenne 57
INStalling...c.cocoeeveveeeninenniiccceeeeee 61
order of installation.......c...cceeceecruenenee. 12
troubleshooting..........ccceeueueccrinununnenee 100
uninstalling IMPAX 5.2 or 5.3.............. 72
uninstalling software...........c.c....... 73, 104
upgrading........coceeevevevecenernenenen 69, 70, 71
workstation preparation tasks order.....21
clinical applications
INStalling...c.coceevveveeencninniccccenee 91

clinical review station recommendations....17
cluster

order of component installation.......... 12

OVEIVIEW..ouvviuirenerenenneneteresessesesseseeesenens 9
colors, Windows desktop................. 38, 41, 44
command-line installation.................... 65, 67
COomMOdO...cuuieeuiiiiieiceiieieeeceeeteeeeeae 59
configuring

CJK support for CD export.......c..c....... 86

language support........ccceceevveueueucncne. 50, 53
configuring cluster........coeceeceverenrueecnennnnes 12
configuring external software

ANTIVITUS..eeerveireenieereenreenretneeeereennene 29
configuring smart card

enrollment station........c.ceeevececrereenenee 87
configuring Windows

Control Panel.......coccveveeveeennneen. 37, 39, 42

Internet Explorer.......cccoocevecenunnenc. 45, 46

language sUPPOTt....cccoeveccevereruerccrennnnee 47

overwriting events as necessary......37, 40

smart card removal......c.ccceceueeceeninnnnenee 55

Windows Explorer..................... 37, 40, 43
Connectivity Manager

verifying upgrade........c.coceververeecnennnne 77
containers

STATION e eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeans 82, 83
Context server

INTEGIationsS....coveuevveuererreeriecrenreenrenenene 79
controller driver

INStalling...c.coceeveeveecninenniccccenee 97
Control Panel

configuring display.......ccceeevecrerenurnenee 37
Control Panel display.......c.cccceuvurueuecncne 39, 42
copyright information..........ccceceveuevneee. 2,107
creating
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certificate TeqUESt......eceveruevererencruenennn. 58

disk partition......cceceeeercreerennencrieneenn 24

disk partitions.........cceeeeereerereeencruesenenn. 23

temporary directory.................. 38, 40, 43
Croatian interface.........coceceveevererenereecncnnne. 46
Curator

order of installation.......c...cceeceveruenenee. 12
currency format, selecting................ 49,52, 54
Czech interface.......ccocevevevenirencresenencncnnne. 46
D
Danish interface.......ccccoveveneencrenenecncnnne. 46
date format, selecting.........c.cccecnve.c. 49, 52, 54
default Client Installer page language......... 86
Dell resource CD, installing...........cceceeeneve. 97
Dell workstation.........ccceeveveeerervereneecncnnenes 14

copying RAID controller..................... 23

installing device drivers......c..ccccceueuene.. 96
device drivers.....coeoeveereruerenieenerieenieeneeaenes 96

controller, installing.......c..cccoeereruenennne. 97

Installing......coceevevevrenneeneencnne, 96, 98

installing resource CD.........cocecereruenenene 97

verifying installation..........cocecevveecnnene. 98
diagnostic monitor requirements............... 14
dialog and desktop colors................ 38, 41, 44
directories

See folders
disabling

automatic Client updates.........cccouue.... 83
disabling animation

Windows Vista.......ceeveeerverereesererencenenes 41
disabling on Windows 7

ANIMATION. cceevereeeeeerrereeeeeese e 43
disabling on Windows Vista

ANIMATION. ceevereeeeeerreneeeeseese e 41
disks

Partitioning.........ceeeeeeeveeveneeennennenn 23,24

space requirements, Windows Vista.....24

space requirements, Windows XP........ 23
displaying status bar..........ccccceeeerrerecnenennes 45
documentation

(O] 1<) 1 1 SOOI 20

giving feedback........cceccveveriruerecncnininnnee 3

uninstalling IMPAX.......ccccccceeererurunee. 104

uninstalling IMPAX 5.2 or 5.3.............. 73

warranty statement........cccoeveiniinniennn. 2
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domain

SETHINGS.cevrverererreerreeriereeereenenes 23, 24, 26
dongle

Agfa Orthopaedic Tools........ccccevuennn. 91

Orthopaedic Application server......... 102
dot NET Framework.................. 15, 63, 71, 75
downloading

Windows updates........ccccccruee.. 39,42, 44
drivers

controller, installing.........ccccccceeevururnenee 97

installing......c.cccoevveccnnnnecncncne. 96, 98

installing hard disk.......cccoceeveerinnnnnnnnee. 23

installing resource CD.........cccccevvuruuenee 97

verifying installation.......c.cececeevceceennnnee 98
Dutch interface.......coeeveeeeeveereeeecvenieeeeeenns 46
E
East Asian language files.......c.ccccoveveruenennne. 46

Installing........coceeevevreeneeencnnne. 47,50, 53
Editline software license..........cccceeveeueenens 108
emailing

documentation feedback............c..cucun... 3
enabling

ACtIVE CONLENT.ceviveeeeeeeeeeeeeeiereeeeeen 45, 46

automated installation............c.ocue..... 65

automatic updates............... 39, 42, 44, 82

language switching.................... 49, 52, 54
English interface........coecevvvevenenenincncnencnnn. 46
enrollment station

adding smart card users......c..c.ceceueueneee. 88

SETHING UP.uveeeuerrerrerererienieneeeneneeseeennens 87
Entrust.. e 59
€ITOL IMNESSAZES .ervverrrerruerruersuersuersuessaessaessaenns 99

BITS Service.....ccoeeeeeveveveeecrrecreecreecveenens 84
Event Viewer configuration................... 37,40
examples

Client installation settings.................... 67
extensions, showing file..........cccoevevurencnee. 40
extensions, showing files.......cc.c.ceeueueee. 37,43
external modem installation.............c.c........ 27
external software

ANTIVITUS.ceteeereeereeereecteeereesteesseesreesseesseens 29

client requirements........cccccceveuereruenenee 15

INStalling...ccoveveeveeniienieereeeeeee 21

JICENSES. ..ocuvenrerietretereeteeeeeeete e, 107
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F

F1 ShOItCUL...ccvieviieiicriceiceeceeceecrecre e 20
files

CrtifiCaAte. uinrrinrrinrreerreerreerreereeerreereereenns 58

extensions, showing................... 37,40, 43
Finnish interface........cocoeevevevevreeveeenreenveennnne 46
Flexgrid for .NET license.......c.ccceoeveeunnnnee 108
folders

creating temporary........ceeceueeee. 38, 40, 43

IMPAX Client.....cceeveeveveeeeeeeneeennne. 63, 75

Installation Server package................... 84

showing folders.......c.ccccceeeuenene. 37,40, 43
fONt COLOTS..uuuviiieeeeeeeeeeeeeeeeeeeeenn 38,41, 44
French interface.........ocoeevveevvevvienvecveeenneennen, 46
G
geographic locations........cccccceveunee. 49, 52, 54
German Interface.......oooeeeereeeevverreeeereennens 46
Globalsign ....coeceveeevereneiecnereccne 59

H

hard drive requirements

ClieNtecuciirererecrecererreeieeeneseeeeeeeene 14

installing driver.........oececeeevvreecncnnnne 23
hardlock driver, installing..........ccccceccrenennee 34
hardware dongle

See dongle
hardware recommendations...........c.ccceuuuu. 17
hardware requirements.........c.cccceueveverueenen 14
headset installation..........ccccceevevvrueueccninnnes 30
hiding

F11ES. ettt e eeeeeean 37, 40, 43
high-performance diagnostic workstation
recommendations.........c.ccceevevuevereeneninnenenen. 17
HIS

CONNECHIVILY.evereereneeeeeeeneeneereeenneneenees 9
Hotfix, NET Framework........ccceuveeuue.. 63,75
HP workstation.......cccccevuvveveenininiinerccncnnnnes 14
Hungarian interface......cccccocevevcrencneecncnnene. 46
|
IE

See Internet Explorer
IIMPAX Reporting supporting software.....33
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IMPAX 5.2

upgrading Clients........c.ccceeeveeverecnennnee 69
IMPAX Client

See Clients
IMPAX Clients

See Clients
IMPAX Clinical Application, installing.......91
IMPAX definition........coeeeereneneeenieencnenenenn 8
IMPAX Enterprise Solution..........ccccccceueunnee 94

COMCEPTLS.cvtiuiirriiniiiiiiiiiitiieeeene e 95
IMPAX Orthogon, installing.........c.c.ccc...... 91
IMPAX PET-CT Viewing, installing............ 91
IMPAX Reporting

installing Speech Client...........ccccueuuue.ee. 32
IMPAX RIS Client reporting solution......... 92
IMPAX RIS supported version.................... 31
IMPAX roles and users, mapping smart card
LU TS RO 89
IMPAX Virtual Colonscopy, installing........ 91
IMPAX Volume Viewing, installing............. 91
importing

SSL certificates.......oeeeereruruerecenennrnnen 60
inserting sound card.......c.coccceeveenurnenee 23,24
installation CD

CTEATING . eueeueeuerrereeeeerienreeeeeneereneeeenenne 62

portable......cooeiniiinienieeeeeeene 56
Installation Server............... 56,57, 61, 82,103

accessing Client Installer page.............. 62

installing SSL certificate.........cceuvuuuenee. 58
installation settings, spacing rules............... 66
installing

Oracle Client......c.coeeeeerneruerccinennnnenen 31

Speech client.......coceceveevrennncncneenen 32
instructions for installing IMPAX Client.....62
integrations

Agfa Orthopaedic Tools.........cccccvuennee 91

clinical application.........cececcveercruenennne 91

Context SEIVEr......ccooivviveviiniiiniessiiinens 79

IMPAX Orthogon......cccccceevereeencnueeneen 91

IMPAX RIS Client.....cccevevveververerverennens 92

OrthoView......coeeceeinnnicccinininiencceaes 91

TalkStatioN...ceceeceeeeeeeeeeeeeeeeeeeeenen 29, 93
interface language.........ccccceneee. 46, 47, 50, 53
Internet EXplorer......ccccccveveneencnencneecncnnne. 15

certificate authorities.........ccccccevvvrunenee. 59

CONfigUIINg.....cccvvruerirverenieenieecennes 45, 46

trusted certificate authorities................ 58
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UPErading.....cevevecrerereererecrenenrenerecenans 28

Italian interface........coceevvevenerencriereneeencnnnes 46
J
JavaScript

SUPPOI T eiiiiiiiiiiiiiiieiieiieieeiiennnes 45, 46

K

Knowledge Bases.....ccccccvueuevereneruencncnnenes 45, 46
IMPAX Client......coceeeeeririruerecininninenen 20
OPENING..cvevenreererreneeieeeenreneeneeeesennens 20
supported languages............ 46, 47, 50, 53
uninstalling IMPAX........ccccccceuvununeee. 104
uninstalling IMPAX 5.2 or 5.3.............. 73

L

Labtec headset installation...........cccceveneee. 30
|anGUAZES. ...cveeeveereeeirieieeeeeeeeeeee e 61
adding......coevevereenrcrneeneeeen 48, 51
adding required.......c.ceccererrnencrrenenen 53
installing East Asian.................. 47,50, 53
Knowledge Base.......ccceoevereverecncrnenenee 20
selecting.....c.coeeeerevreneneeeneenenes 49,52, 54
selecting default.......cccoceeevueenuenennne. 48, 51
SWItChING...veueeeeveirrecreeceeeenes 49, 52, 54
language Support......coeceveeererreenen 47, 50, 53
licenses
external software.........ccoeeveeveeveennenne. 107
local clients......coceeeveeeveeereeereeereereceeceeeeene 9
locale
WIndows Vista......cceceevveerveeveeeeeneennennes 24
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